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Notices
While reasonable efforts have been  made to ensure that the information in
this document is complete and accurate at the time of printing, Avaya
assumes no liability for any errors. Avaya reserves the right to make changes
and corrections to the information in this document without the obligation to
notify any person or organization of such changes.

Documentation disclaimer
Avaya shall  not be responsible for any modifications, additions, or deletions
to the original published version of this documentation unless such
modifications, additions, or deletions were performed by Avaya.

End User agree to indemnify and hold harmless Avaya, Avaya's agents,
servants and employees against all claims, lawsuits, demands and judgments
arising out of, or in connection with, subsequent modifications, additions or
deletions to this documentation, to the extent made by End User.

Link disclaimer
Avaya is not responsible for the contents or reliability of any linked Web sites
referenced  within this site or documentation(s) provided by Avaya.  Avaya is
not responsible for the accuracy of any information, statement or content
provided on these sites and  does not necessarily endorse the products,
services, or information described or offered within them. Avaya does not
guarantee that these links will work all the time and has no control over the
availability of the linked pages.

Warranty
Avaya provides a limited warranty on this product. Refer to your sales
agreement to establish the terms of the limited warranty. In addition, Avaya’s
standard warranty language, as well as information regarding support for this
product, while under warranty, is available to Avaya customers and other
parties through the Avaya Support Web site: http://www.avaya.com/support.
Please note that if you acquired the product from an authorized Avaya reseller
outside of the United States and Canada, the warranty is provided to you by
said Avaya reseller and not by Avaya.

Licenses
THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA WEBSITE,
HTTP://SUPPORT.AVAYA.COM/LICENSEINFO/  ARE APPLICABLE TO ANYONE
WHO DOWNLOADS, USES AND/OR INSTALLS AVAYA SOFTWARE,
PURCHASED FROM AVAYA INC., ANY AVAYA AFFILIATE, OR AN AUTHORIZED
AVAYA RESELLER (AS APPLICABLE) UNDER A COMMERCIAL AGREEMENT
WITH AVAYA OR AN AUTHORIZED AVAYA RESELLER. UNLESS OTHERWISE
AGREED TO BY AVAYA IN WRITING, AVAYA DOES NOT EXTEND THIS
LICENSE IF THE SOFTWARE WAS OBTAINED FROM ANYONE OTHER THAN
AVAYA, AN AVAYA AFFILIATE OR AN AVAYA AUTHORIZED RESELLER, AND
AVAYA RESERVES THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU AND
ANYONE ELSE USING OR SELLING THE SOFTWARE WITHOUT A LICENSE. BY
INSTALLING, DOWNLOADING OR USING THE SOFTWARE, OR AUTHORIZING
OTHERS TO DO SO, YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR
WHOM YOU ARE INSTALLING, DOWNLOADING OR USING THE SOFTWARE
(HEREINAFTER REFERRED TO INTERCHANGEABLY AS “YOU” AND “END
USER”), AGREE TO THESE TERMS AND CONDITIONS AND CREATE A
BINDING CONTRACT BETWEEN YOU AND AVAYA INC. OR THE APPLICABLE
AVAYA AFFILIATE (“AVAYA”).

Avaya grants End User a license within the scope of the license types
described below. The applicable number of licenses and units of capacity for
which the license is granted will be one (1), unless a different number of
licenses or units of capacity is specified in the Documentation or other
materials available to End User. "Designated Processor" means a single
stand-alone computing device. "Server" means a Designated Processor that
hosts a software application to be accessed by multiple users. "Software"
means the computer programs in object code, originally licensed by Avaya
and ultimately utilized by End User, whether as stand-alone products or
pre-installed on Hardware. "Hardware" means the standard hardware
originally sold by Avaya and ultimately utilized by End User.

License types
Designated System(s) License (DS). End User may install and use each copy
of the Software on only one Designated Processor, unless a different number
of Designated Processors is indicated in the Documentation or other materials
available to End User. Avaya may require the Designated Processor(s) to be
identified by type, serial number, feature key, location or other specific
designation, or to be provided by End User to Avaya through electronic means
established by Avaya specifically for this purpose.

Copyright
Except where expressly stated otherwise, no use should be made of materials
on this site, the Documentation(s) and Product(s) provided by Avaya. All
content on this site, the documentation(s) and the product(s) provided by
Avaya including the selection, arrangement and design of the content is
owned either by Avaya or its licensors and is protected by copyright and other
intellectual property laws including the sui generis rights relating to the
protection of databases. You may not modify, copy, reproduce, republish,
upload, post, transmit or distribute in any way any content, in whole or in
part, including any code and software.  Unauthorized reproduction,
transmission, dissemination, storage, and or use without the express written
consent of Avaya can be a criminal, as well as a civil, offense under the
applicable law.

Third Party Components 
Certain software programs or portions thereof included in the Product may
contain software distributed under third party agreements ("Third Party
Components"), which may contain terms that expand or limit rights to use
certain portions of the Product ("Third Party Terms"). Information regarding
distributed Linux OS source code (for those Products that have distributed the
Linux OS source code), and identifying the copyright holders of the Third
Party Components and the Third Party Terms that apply to them is available
on the Avaya Support Web site: http://support.avaya.com/Copyright.

Preventing toll fraud
"Toll fraud" is the unauthorized use of your telecommunications system by an
unauthorized party (for example, a person who is not a corporate employee,
agent, subcontractor, or is not working on your company's behalf). Be aware
that there can be a risk of toll fraud associated with your system and that, if
toll fraud occurs, it can result in substantial additional charges for your
telecommunications services.

Avaya fraud intervention
If you suspect that you are being victimized by toll fraud and you need
technical assistance or support, call Technical Service Center Toll Fraud
Intervention Hotline at +1-800-643-2353 for the United States and Canada.
For additional support telephone numbers, see the Avaya Support Web site:
http://support.avaya.com
Suspected security vulnerabilities with Avaya products should be reported to
Avaya by sending mail to: securityalerts@avaya.com.

Trademarks
Avaya and Aura are trademarks of Avaya, Inc.
The trademarks, logos and service marks (“Marks”) displayed in this site, the
documentation(s) and product(s) provided by Avaya are the registered or
unregistered Marks of Avaya, its affiliates, or other third parties.  Users are
not permitted to use such Marks without prior written consent from Avaya or
such third party which may own the Mark. Nothing contained in this site, the
documentation(s) and product(s) should be construed as granting, by
implication, estoppel, or otherwise, any license or right in and to the Marks
without the express written permission of Avaya or the applicable third party.
Avaya is a registered trademark of Avaya Inc. All non-Avaya trademarks are
the property of their respective owners.

Downloading documents
For the most current versions of documentation, see the Avaya Support Web
site: http://www.avaya.com/support

Contact Avaya Support
Avaya provides a telephone number for you to use to report problems or to
ask questions about your product. The support telephone number is
1-800-242-2121 in the United States. For additional support telephone
numbers, see the Avaya Web site: http://www.avaya.com/support
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Voicemail Pro

Chapter 1.
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Voicemail Pro:  

1. Voicemail Pro
The diagram illustrates a Voicemail Pro system with some of the setup options. 

· IP Office Control Unit 
The IP Office Voicemail Pro licenses  are entered into the configuration of the IP Office system. The licenses are
required to activate Voicemail Pro features. An unlicensed Voicemail Pro service will run for two hours to allow
demonstration and testing. License keys are issued against and validated against the unique serial number of the
feature key dongle used by the IP Office. 

· Voicemail Pro Server 
The Voicemail Pro service is installed onto a server PC. This becomes the PC where messages and other data are
stored for the mailboxes and services provided by Voicemail Pro. The server can be a Windows or Linux based
server. 

· Multiple Servers 
There are a number of scenarios where multiple Voicemail Pro servers can be supported. For example to
provide a backup voicemail server or to support multiple IP Office systems in a network. See Centralized
Voicemail Pro . 

· Voicemail Pro Client
The Voicemail Pro Client is used to administer the Voicemail Pro service. The client is a Windows application that
can be installed on another computer to allow remote administration of the   the server. Only one client can connect
to the server at any time. 

· The version of Voicemail Pro client used with a Voicemail Pro server should match. If the Voicemail Pro client is
used to load a call flow from an earlier version of Voicemail Pro server, you will be warned that if you edit the
call flow you will not be able to save it back to the original server. If the client is used to load a call flow from a
later version of Voicemail Pro server it will stop the action and prompt that the call flow cannot be loaded.

· Telephone Extension 
For internal extensions, the voicemail server provides message waiting indication. This is done automatically for the
phone user's own mailbox. However, the user can be configured to also receive message waiting indication for
other mailboxes. 

· User's PC 
In addition to accessing mailbox voicemail messages through the phone, there are a range of method for accessing
messages from a user's computer. This can be by web browser, IMAP email account, Exchange 2007 email account
and various other options. The IP Office one-X Portal for IP Office and IP Office Phone Manager applications can also
be used. 

· Email Server 
Using an email server, Voicemail Pro can provide a number of services. This includes send messages alerts or copies
of messages. For Exchange 2007 email servers, the email server can be used as the message store with users
accessing their messages using Outlook 2007. 

10
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· ContactStore Server 
In addition to taking voicemail messages, the Voicemail Pro can be used for automatic and manual call recording.
These recordings are normally stored in the voicemail servers mailboxes. ContactStore for IP Office is an additional
licensed application to which recordings can be transferred for long term storage. ContactStore supports archiving
to DVD, access by web browser and searching based on call details. 

· Installation of ContactStore for IP Office is covered in its own separate installation manual. It is recommended
that Voicemail Pro installation is completed and tested before the additional installation of ContactStore for IP
Office. 
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Voicemail Pro:  

1.1 Supported Languages
By default the prompts installed match the installer language selection plus English. If other languages are required they
need to be selected by doing a custom installation. The installable Voicemail Pro prompts are listed in the table below. The
availability of a language in voicemail does not necessarily indicate support for IP Office in a country that uses that
language. 

Language WAV
Folder

Fallback Selection TTS 5.0

Brazilian Portuguese ptb > pt > en.

Chinese (Cantonese) zzh > en > enu.

Chinese (Madarin) ch > en > enu.

Danish da > en.

Dutch nl > en.

English UK en en.

English US enu > en.

Finnish fi > en.

French fr > frc > en.

French Canadian frc > fr > enu > en.

German de > en.

Greek el > en.

Hungarian hu > en.

Italian it > en.

Korean: ko > en.

Latin Spanish eso > es > enu > en.

Norwegian no > en.

Polish pl > en.

Portuguese pt > ptb > en.

Russian ru > en.

Spanish es > eso > en.

Swedish sv > en.

When the IP Office routes a call to the voicemail server it indicates the locale for which matching prompts should be
provided if available. Within the IP Office configuration, a locale is always set for the system. However differing locales can
be set for each user, incoming call route and for short codes in addition to the default system locale. 

The locale sent to the voicemail server by the IP Office is determined as follows:

Locale Source Usage

Short Code Locale The short code locale, if set, is used if the call is routed to voicemail using
the short code. 

System Locale If no user or incoming call route locale is set system locale is used unless
overridden by a short code locale. 

Incoming Call Route Locale The incoming call route locale, if set, is used if caller is external.

User Locale The user locale, if set, is used if the caller is internal.

If the prompts matching the IP Office locale are not available, the voicemail server will provide prompts from a fallback
language if available. The table of languages above lists the order of fallback selection. 

If required, the language provided by a voicemail call flow can be changed using a  Select System Prompt
Language action. 

TTY Teletype Prompts
TTY (Teletype (Textphone)) is included in the list of installable languages. TTY is a text-based system that is used to
provide services to users with impaired hearing.
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1.2 Voicemail Pro Licenses
The Help | About screen in the voicemail client can be used to check which IP Office the voicemail server is working and
the licenses it has received from that IP Office. 

The license keys are entered into the IP Office configuration using the IP Office Manager. If the Voicemail Pro server is
installed without licenses, it will run for 2 hours and then shutdown.

For IP Office Release 6, support for Voicemail Pro is enable by the addition of a Preferred Edition license. 

·  Preferred Edition (Voicemail Pro) : 
This license enables support for Voicemail Pro as the IP Office's voicemail server with 4 voicemail ports.  The
Preferred Edition license allows the voicemail server to provide the services listed below. Additional license can be
added for additional voicemail features, these are detailed separately. This license was previously called Voicemail
Pro (4 ports). 

· Mailboxes for all users and hunt groups. 

· Announcements for users and hunt groups. 

· Customizable call flows. 

· Call recording to mailboxes. 

· Campaigns. 

· TTS email reading for users licensed for Mobile
User or Power User profiles.

· Use of Conference Meet Me functions on
IP500 and IP500 V2 systems. 

·  Advanced Edition 
This license enables the additional features listed below. A Preferred Edition license is a pre-requisite for this
license. 

· Support for Customer Call Reporter. 

· Voicemail Pro database interaction (IVR). 

· Voicemail Pro call flow generic TTS (8 ports).[1]

· Voicemail Pro Visual Basic Scripting. 

· Voicemail Pro call recording to ContactStore.[2]

1.Provides up to 8 ports of TTS for use with Speak Text actions within call flows. Not used for user TTS email
reading. 

2.Note: In a Small Community Network using centralized voicemail, this license only enables ContactStore
support for the central IP Office. Remote IP Offices in the network require their own Advanced Edition
license or a VMPro Recordings Administrator license . 

·  Preferred Edition Additional Voicemail Ports 
The required license for Voicemail Pro server support (Preferred Edition (Voicemail Pro)) also enables 4 voicemail
ports. This license can be used to add additional voicemail ports up to the maximum capacity of the IP Office
system (IP406 V2 = 20, IP412 = 30, IP500 = 40, IP500 V2 =40). This license was previously called Additional
Voicemail Pro (ports). 

·  VMPro Recordings Administrators : 
To support ContactStore in a Small Community Network, IP Offices other than the central IP Office require either
their own Advanced Edition license or this license. 

·  VMPro Networked Messaging : 
Enables VPNM (Voicemail Pro Networked Messaging) functionality within Voicemail Pro. This allows message
exchange with remote Voicemail Pro systems and Avaya Interchange systems. 

·  VMPro TTS (Generic) :  
This legacy license enables use of text to speech facilities using third party TTS software with Voicemail Pro. One
license per simultaneous instance of TTS usage. For IP Office Release 6 this license is no longer used for user email
reading. The IP Office Advance Edition license also enables 8 ports of generic TTS. 

·  VMPro TTS (ScanSoft) : 
This legacy licence enables use of text to speech facilities using Avaya supplied TTS software with Voicemail Pro.
One license per simultaneous instance of TTS usage. For IP Office Release 6 this license is no longer used for user
email reading. 
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Voicemail Pro: Voicemail Pro Licenses

Legacy Licenses
The following legacy licenses are still supported by IP Office Release 6. 

·  UMS Web Services 
This legacy license is used to enable UMS voicemail services support for users set to the Basic User profile.
Other users are enabled for UMS through their licensed user profile. 

·  VMPro Database Interface : 
This legacy license enables 3rd party database support within Voicemail Pro call flows. For IP Office Release 6
this is also enabled by the Advanced Edition license. 

·  VMPro VB Script :  
This legacy license enables Visual Basic Script support with Voicemail Pro. For IP Office Release 6 this is also
enabled by the Advanced Edition license. 

1.3 Number of Simultaneous Users
All connections between the voicemail server and the IP Office are via the LAN using data channels. The maximum number
of data channels that can be used for voicemail operation at any moment are shown below. 

IP Office Maximum for
Voicemail Pro

IP500 40

IP500 V2 40

The actual number of simultaneous users is determined by the licenses for Voicemail Pro  added to the IP Office
configuration. Note also that some specific functions can have voicemail channels reserved  for their use or may have
channel restrictions. 

 

10
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Windows Server Installation

Chapter 2.
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2. Windows Server Installation
This section covers the installation of the Voicemail Pro server onto a Windows server PC. Voicemail Pro 7.0 can be
installed with the following IP Office systems running IP Office Release 7.0 software: 

· IP Office 500

· IP Office 500v2

2.1 General Installation Requirements
Here is a list of general requirements for all types of voicemail installation. 

· A PC with IP Office Manager and Microsoft .NET Framework versions 2.0 installed on it. If .NET 2.0 is not detected,
you will be prompted to install it before the Voicemail Pro installation proceeds.

· An IP Office Feature Key. Refer to the IP Office Installation Manual for details. 

· Licenses based on the serial number of the IP Office Feature Key. These should include: 

· A license for Voicemail Pro and any additional voicemail ports is required. If Voicemail Pro Server is installed
without a license it will run for 2 hours and then shut down.

· Licenses for any other Voicemail Pro components being installed, see Voicemail Pro Licenses .

· IP Office Applications DVD. 

 

Tips

· Before you start to install Voicemail Pro it is advisable to check that the PC that you are using can connect to the IP
Office unit and that you can load and save a configuration file using IP Office Manager.

· Switch off any PC and hard disk sleep, power down, suspend, hibernation modes.

· The Voicemail Pro software needs to be installed using an account with full administrator rights on the PC. The
service subsequently runs under that account. We recommend that a specific account is created for this purpose
and set so that its password does not expire.

10
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Windows Server Installation: General Installation Requirements

2.1.1 PC Specification
The PC specifications given below are the minimum required. To avoid having to replace the server when upgrading we
recommend that at least a Pentium 4 2.8GHz or higher is used wherever possible.

This application requires various licenses entered into the IP Office configuration to control the features it offers and the
number of simultaneous connections , up to 40 on IP Office 5.0+ IP500 control units. The operation of Voicemail Pro
can be customized to provide special services.

The Voicemail Pro software can be installed as separate Voicemail Pro client and server parts. This allows the remote
administration of the Voicemail Pro server from a PC with just the Voicemail Pro client installed. A copy of the client is
automatically installed locally with the Voicemail Pro server.

Source

DVD IP Office 7.0 Application DVD (Disk 1)

Languages See Supported Languages .

IP500  IP Office Standard Edition[1],  IP Office Professional Edition.

License  See below.

1.For pre-IP Office 5.0 IP500 systems, an IP500 Upgrade Standard to Professional licenses is required to support
Voicemail Pro. 

The Voicemail Pro server part of the software consists of several components in addition to the core server software, these
are:

· Campaigns 
The Voicemail Pro can be configured to run a campaign. This consists of a series of questions for which the
Voicemail Pro records the callers answer or key presses. The resulting recordings can then be played back by users.
The web aspect of campaigns allows user to perform this playback and processing of campaign recordings via their
web browser. This requires an IIS web server to be run on the same PC as the Voicemail Pro software.

· Text to Speech (TTS) 
Through adding additional licenses, the Voicemail Pro is able to use the TTS functions of Windows to speak text and
numbers to callers in addition to recording prompts. This is intended mainly for scenarios where the Voicemail Pro is
obtaining text and number values from a customer database.

· UMS Web Voicemail
UMS allows users to access their voicemail mailbox using either an IMAP compatible email program or through their
web browser. UMS Web Voicemail requires the Voicemail Pro service to be installed on a server PC that has IIS
already present. It also installs PHP if not detected as already present. 

 

· Installation on Windows Server Operating Systems
On many Windows server PC's, while the Windows Audio components are present by default they are not always
enabled. If this is the case the playback of voice prompts may be 'choppy' and the TTS (if installed) will not work.
However, enabling Windows Audio does not require the server PC to have a sound card installed. 

1.Ensure that you have full administrator rights for the PC. This process will also require the PC to be restated. 

2.In the Windows Control Panel select Sounds and Audio Devices. 

3. If Windows Audio has not been enabled, select the Enable Windows Audio check-box. 

Notes:

1. Use of the Large Fonts setting is not supported. Use of this option may cause options on some screens to become
inaccessible.

2. A 100Mbps network card is strongly recommended.

3. Free disk space requirements  are also subject to the message storage required. 

11

9

20



Voicemail Pro Installation Page 16
- Issue 01a (01 May 2011)IP Office Release 7.0

Basic Voicemail Pro

Minimum PC Requirements

RAM 256MB

Hard Disk Free Space 2GB*

Processor:

- Pentium P4 1.4GHz

- Celeron Any 1.7GHz

- AMD Any 1.4GHz.

*Also allow 1MB per minute for message and prompt storage.

Operating System Support

Server OS: Service Client

2003 Server

2008 Server

Client OS:

XP Professional

Vista

Windows 7

Voicemail Pro plus UMS Web Voicemail and/or Campaigns

Minimum PC Requirements

RAM 512MB

Hard Disk Free Space 2GB*

Processor:

- Pentium P4 2.8GHz

- Celeron Not tested.

- AMD Athlon XP 3000+, Athlon 64

*Also allow 1MB per minute for message and prompt storage. 

Operating System Support

Server OS: Service Client

2003 Server

2008 Server

Client OS:

XP Professional

Vista

Windows 7

· Both Web Campaigns and UMS Web Voicemail require the IIS web server on the voicemail server PC to be
enabled. 

· UMS Web Voicemail will install PHP if not detected as already installed. 

Voicemail Pro plus IVR and or TTS

Minimum PC Requirements: Basic Voicemail Pro

RAM 512MB

Hard Disk Free Space 20GB*

Processor:

- Pentium P4 2.8GHz

- Celeron Not tested. 

- AMD Athlon XP 3000+, Athlon 64

Also allow 1MB per minute for message and prompt storage.

*Generic TTS only. The current ScanSoft TTS provided with
Voicemail Pro is not supported on Vista. 

Operating System Support

Server OS: Service Client

2003 Server

2008 Server

Client OS:

XP Professional

Vista 

Windows 7

· If the database being queried is located on the VM Pro server, the query speed of the database will be affected by
the amount of memory available. Please take into account the memory requirements of the database being queried.

Voicemail Pro and IP Office Customer Call Reporter
Voicemail Pro and IP Office Customer Call Reporter can be run on the same server up to a maximum of 16 Voicemail Pro
ports. Supported on a Dual Core CPU of 2.4Ghz and higher. The separate requirements of Voicemail Pro and Customer Call
Reporter must be met. 
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Windows Server Installation: General Installation Requirements

Ports
The Voicemail Pro service uses the following ports. 

Port Number Type Description

25 TCP Used to listen for SMTP connections.

37 UDP Used to receive time requests (RFC 868).

143 TCP Used to service IMAP4 requests.

50791 UDP Used to receive requests from IP Office PBX.

TCP Used to receive requests fromone-X Portal for IP Office.

50791 TCP Used to receive connections from Voicemail Pro client.

Note that additional ports may be used for connection to services such as 3rd party database or Microsoft Exchange. 
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2.1.2 Virtual Server Support
Operation of IP Office server applications, including Voicemail Pro, is supported using the following virtual servers. 

· VMWare Server. 

· Microsoft Virtual Server 2005 R2. 

· Microsoft Server Hyper-V.

2.1.3 Single Server Support
The following scenarios are supported for combining IP Office server applications onto a single Windows server PC. 

In all cases, the individual requirements of each application as if installed on a separate server are still applicable. Also,
depending on the application combination, additional restrictions and requirements may be applied as detailed below. 

Voicemail Pro Customer Call
Reporter

one-X Portal for IP
Office

Minimum IP
Office Release

Minimum PC
Specification

1. 16 Ports 150 Agents – Release 5.0 As per each
application. 

2. 8 Ports 
(4 TTS)

– 50 Simultaneous
users.

Release 6.0 2GHz Dual Core, 4GB
RAM, Windows 2008
Server (32 or 64-bit).

3. 8 Ports 
(4 TTS)

30 Agents 50 Simultaneous
users.

Release 6.0 2GHz Quad Core, 6GB
RAM, Windows 2008 
64-bit.

CCR run in Windows
2003 on a virtual
server. 

4. 16 ports 
(8 TTS)

50 Agents 150 Simultaneous
users.

Release 6.0

· Voicemail Pro includes UMS, VB Scripting and 3rd party database operation. It also includes the installation of
ContactStore if required. 

· Both ContactStore and one-X Portal for IP Office use Tomcat servers as part of the application. For scenarios with
both installed, the redirect port setting of the ContactStore's Tomcat server should be configured to a port other
than 8080. 

· The supported virtual servers are: 

· VMWare Server. 

· Microsoft Virtual Server 2005 R2. 

· Microsoft Server Hyper-V.

· When used in a virtual server configuration, Customer Call Reporter and one-X Portal each require a 2GB RAM
virtual machine. Voicemail Pro and ContactStore each require a 1GB RAM virtual machine. 



Voicemail Pro Installation Page 19
- Issue 01a (01 May 2011)IP Office Release 7.0

Windows Server Installation: General Installation Requirements

2.1.4 Network Requirements
The PC should be configured and tested for TCP/IP networking.

We strongly recommend that the voicemail server PC is connected to the IP Office Control Unit directly or via a LAN
switch.

If directly connected, changing the settings of the PC network card to match the IP Office control unit can resolve some
issues. This should be done according to the PC or network card manufacturer's instructions. The options for IP Office LAN
ports are:

· All IP Office LAN ports are 10Mbps/100Mbps auto sensing.

If not directly connected, using any of the above settings must be supported and matched by the intervening network
equipment.

· The PC should have a fixed IP address. Although PCs in a DHCP network may retain the same IP address between
reboots this is not guaranteed.

· If the IP Office is acting as a DHCP server, it defaults to using 192.168.42.2 to 192.168.42.201 for DHCP clients.
This leaves 192.168.42.202 to 192.168.42.254 for devices that require fixed IP addresses.
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2.1.5 Disk Space Requirements
The following are only approximations: 

· At least 2GB of free disk space is required on the operating system drive (by default c:), regardless of to which
drive Voicemail Pro is actually installed.

· A compact Voicemail Pro installation requires 130MB. 

· A typical installation requires approximately 255MB. 

· A custom installation requires up to 2GB of disk space. However, prompts and recorded messages consume an
additional 1MB of disk space per minute.

· For a busy environment you can expect to require at least 1000 minutes of message recording space, that is 1GB.

· If you are installing the Client only, you can expect to require at least 170MB.

2.1.6 Web Server Operation
If web browser access is required, the Microsoft IIS Web Server must be installed on the server PC before Voicemail Pro
is installed:

· Microsoft web server products run as services and require Voicemail Pro to also run as a service. 

· Internet Information Server 5.0 or higher is required.

 

2.1.7 ContactStore Operation
The current IP Office Voice Recording Library (VRL) application is Avaya IP Office ContactStore. This application and its
installation are documented separately, however:

· IP Office ContactStore should be installed after Voicemail Pro has been installed and its operation verified.

· IP Office ContactStore must use a separate hard disk partition for its message archiving from that used by
Voicemail Pro for current mailbox messages. Use of a separate hard disk or installation onto a separate server PC
are alternatives. 

· The use of ContactStore to store recordings requires additional voicemail licenses . The IP Office hosting the
Voicemail Pro server must have an Advanced Edition license. If in a Small Community Network, other IP Offices in
the network wanting to use ContactStore must have either Advanced Edition licenses or VMPro Recordings
Administrators licenses. 

· The use of RAID 1 or RAID 5 are recommended.

· The use of a DVD recorder for long-term archiving is recommended.

· A figure of 7.2MB per hour for archived recordings is given.

· The archived messages held by IP Office ContactStore are accessed via web browser using the port address 8888.
This port address is not configurable and so it is necessary to ensure that it does not conflict with any other web
server service running on the same server PC. 

10
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2.2 Server/Client Installation
The Voicemail Pro installation software for Windows offers a number of different types of installation. The key types are
client only, compact, typical and custom. These differ in the components installed as detailed in the table below.

Component Sub Component Installation Type Notes

Client Compa
ct

Typica
l

Custo
m

Voicemail
Pro

Voicemail Pro
Client

Voicemail Pro
Service

Languages Installs the prompts that best match the server
PC locale plus English prompts. For an installation
with additional languages use the Custom
installation option.

Voicemail Pro Campaign Web
Component

Not available for installation on an XP Pro server. 

Web Voicemail (UMS) Only available for installation on server operating
systems. 

Before you begin:

1.Log on to the server PC using the account under which you intend the Voicemail Pro server or service to run. This
account must have full administrator rights to the server PC.

2.Recommendation 
Create a new user account called Voicemail and give it full administrator rights on the PC. This will help to identify
the purpose of the account. Set the account password so that it does not expire. 

3.In IP Office Manager, check that the correct licenses for Voicemail Pro  have been installed and show a status of
Valid. 

4.For installations other than client only and compact, check that the necessary pre-installation processes have been
completed: 

· Web Campaigns Installation

· Voicemail Email Installation

· UMS Web Voicemail  

· IMAP Installation

· Web Voicemail Installation

· Exchange 2007 Installation

· Centralized Voicemail Pro

· Installing Text to Speech Features

· Voicemail Private Networked Messaging (VPNM) Installation

· Installation on Windows Server Operating Systems
On many Windows server PC's, while the Windows Audio components are present by default they are not always
enabled. If this is the case the playback of voice prompts may be 'choppy' and the TTS (if installed) will not work.
However, enabling Windows Audio does not require the server PC to have a sound card installed. 

1.Ensure that you have full administrator rights for the PC. This process will also require the PC to be restated. 

2.In the Windows Control Panel select Sounds and Audio Devices. 

3. If Windows Audio has not been enabled, select the Enable Windows Audio check-box. 

10
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To install the Voicemail Pro software components:

1.Insert the IP Office Applications DVD. Click on the link for Voicemail Pro and then double-click on setup.exe. 

2.The Choose Setup Language menu is displayed. This language is used for the installation process and does not
affect the language prompts that are installed. 

3.Select the language for the installation process. Click OK. 

4.The Preparing Installation menu is displayed. 

· Voicemail Pro requires Microsoft .NET 2.0 Framework. If this is not detected, you will be prompted to install it.
Click Yes to install Microsoft .NET 2.0 Framework.

· If the Modify, repair or remove the program window appears you need to follow the upgrade process . 

5.The Welcome window is displayed. Click Next. 

6.The Customer Information menu is displayed. 

· Use the default names or enter a user and company name. These settings do not affect the Voicemail Pro
installation.

· Select the option Anyone who uses this computer (all users).

· Click Next. 

7.The Choose Destination Location menu is displayed. Unless specifically required, for ease of maintenance use
the proposed folder location. Click Next. 

8.The Messaging Components menu is displayed.

9.Select Voicemail Pro (Full) or Voicemail Pro Client - Only. Click Next. If Voicemail Pro Client - Only was
selected, go to step 14. 

10.The Setup Type menu is displayed. Select Compact, Typical or Custom and click Next. 

· If the option selected was Custom, the Select Features menu is displayed. Select the components required
for the installation and click Next.

11.The Service Account Name menu is displayed. This window is used to select the account under which the
Voicemail Pro services will be run following installation. 

· Enter the user name and password of the account to use. Alternatively, click Browse and select a name from
the list of available PC or network accounts.

· Click Next. The account name and password are validated. If the validation fails you whether you want to
create a new account that matches the details entered. 

12.The Select Program Folder menu is displayed. By default, the program folder for the Voicemail Pro client is set
to IP Office. For ease of maintenance use this option unless there is a specific reason to use a different folder. Click
Next. 

13.The Start Copying Files menu is displayed. It shows a summary of the components that are about to be
installed. Check that this list is as expected. If for any reason the details are not what you expect, click Back and
make the necessary changes. When you are satisfied that the details are correct, click Next to start copying the
files.

14.The Setup Status menu is displayed. This shows you the progress of the file installation. For a client only
installation, the software installation process is now completed. 

15.The InstallShield Wizard Complete menu is displayed. 

16.Depending on the operating system and the components installed you may be prompted to restart the computer.
If so select Yes, I want to restart my computer now.

17.Click Finish.

18.If necessary, the computer will restart and you will need to log in to continue the installation process. If otherwise,
the installation process continues without restarting.

19.The installation process continues by requesting a number of configuration settings used by the voicemail server
services, 

1.The IP Office Voicemail Pro Email Settings window is displayed. This is used to enter the account that the
voicemail pro server should use for email functions. Enter the name of the email account to use or click 
Browse and select an account to use. Click Next. 

2.The IP Office Voicemail Pro SMTP Email Settings window opens. 

3.In the Mail Server box, type the name of the SMTP mail server or use the name that is proposed. This should
be the fully qualified domain name. 

4.In the Port Number box, type the number of the receiving port on the SMTP mail server. The default is 25.

28
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5.To enforce server authentication, check the Server Requires Authentication box. This is optional. If you
check it you also need to provide the Account Name and Password that need to be entered. You can also
choose whether or not to set the Use Challenge Response Authentication option.

6.Click Finish. An attempt is made to validate the email settings. An error message is displayed when the
attempt to connect with an SMTP server fails. Click OK to acknowledge the message. 

20.You have now finished installing the Voicemail Pro server and client software. 

21.If doing a custom installation to install a specific Voicemail Pro feature, refer to the appropriate section for details
of any actions that need to be performed after the installation of the Voicemail Pro server software. 

· Web Campaigns Installation

· Voicemail Email Installation

· UMS Web Voicemail  

· IMAP Installation

· Web Voicemail Installation

· Exchange 2007 Installation

· Centralized Voicemail Pro

· Installing Text to Speech Features

· Voicemail Private Networked Messaging (VPNM) Installation

Initial Configuration
Following installation of the server and client, you should check operation by using the client to connect to the server. 

1.Select Start | Programs | IP Office | Voicemail Pro. The Voicemail Pro Client starts and the main window
opens.

2.Change the default remote administrator account details:

a. In the navigation panel, click on Voicemail Pro Administrators. There should be one account called
Administrator.

b.Double-click on the account (or right click and select Modify). 

c. Change the Password and Confirm Password to a new value than the default (Administrator).

3.Initialize the server call flow:

a.Click the  Save and Make Live icon.

b.Select Yes. The file root.vmp is created on the server. This is the compiled non-editable version of the call
flow that is used by the server.

c. Voicemail operation can now be tested from an extension by dialing *17.

4.You can now start configuring the operation of the voicemail server, for example changing the system preferences
. 
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2.2.1 Modifying the Installed Components

1.Start the Windows Control Panel. 

2.Select Add and Remove Programs. 

3.Select IP Office Voicemail Pro from the list of installed applications. 

4.Click on Change. 

5.Select Modify and click Next. 

6.The Select Features menu is displayed. The existing installed components are indicated by a tick mark. 

7.Select the additional components required for the installation. 

8.Not that de-selecting a component will cause it to be uninstalled. 

9.Click Next. 

10.The process continues are a normal installation . 21
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2.2.2 Web Campaigns Installation
The web campaigns component of Voicemail Pro requires IIS to be installed and running on the server PC. 

1.Check that IIS is installed and running on the server PC. 

· Windows 2008 Server IIS does not support legacy IIS applications such as Campaigns by default. This is
rectified by reinstalling IIS from the Windows installation disk and selecting Legacy IIS support during the
installation.

2.Check that the server PC can be browsed from other PC's on the customer network. 

3.If the Voicemail Pro server software has not yet been installed: 

· Run the Voicemail Pro software installation  and select Voicemail Pro (Full). 

· Select either Typical or Custom. If Custom is selected, ensure that Voicemail Pro Campaigns Web is
selected in the list of components. 

4.If the Voicemail Pro server software is already installed: 

· Modify the installed components and ensure that Voicemail Pro Campaigns Web is selected in the list of
components. 

Windows 2003 Server
The following configuration changes are required for IIS version 6 after installation of the Voicemail Pro web campaigns
component.

1.Open the Windows Control Panel.

2.Select Administrative Tools | Computer Management.

3.Go to Services and Applications | IIS Manager | Web Sites | Default Web Site.

4.Under Web Sites, right-click Default Web Site and select Properties.

· Select the Home Directory tab.

· Under Application Settings section, set the Execute Permissions to Scripts and Executables.

· Click OK twice.

5.Under Web Sites, go to Web Service Extensions.

6.Right-click and select Add a new web service extension.... 

· Set the following values:

· Extension Name: campaigns.

· Required files: Click Add. Select the file type as CGI exe files and browse to the campaign.exe file
location specified during installation. This is usually c:\InetPub\wwwroot\scripts\campaign.exe or c:
\InetPub\scripts\campaign.exe.

· Set extension status to Allowed.

· Press OK.

21
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2.2.3 The Voicemail Pro Services
If Voicemail Pro has been installed successfully, if the server PC has been rebooted then the voicemail service is started
automatically. However it is useful know how to check the services and to manually restart them if necessary.

To check/restart the Voicemail Pro Service:

1. Open the Windows Control Panel.

2. Select Administrative Tools > Services. 
 

3. The Voicemail Pro Service should be visible. Its Status should be Started and the Startup Type should be set
to Automatic. Other services may be present depending on the Voicemail Pro options installed. The possible
services are: 

· Voicemail Pro Service
This is the main Voicemail Pro service. Normally this is the only service that needs to be stopped and
restarted. It will stop and restart the other services that it uses.

4. Close Services.

Setting the Voicemail Services or PC to Restart Automatically
The following action is optional. If there is some fault causing the Voicemail Pro service to halt, that fault should be
investigated and fixed, however having the service or PC automatically restarted if possible will minimize the disruption to
the Voicemail Pro users. 

1.Use the Windows control panel to select the Voicemail Pro Service. 

2.Right-click on the service and select Properties. 

3.Select the Recovery tab. 

4.Use the options presented to either restart the service and or restart the PC should the operating system detect
that the Voicemail Pro service has halted. 
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Using a Batch File to Start Services 
In some instances, certain computers might not respond quickly enough in order to start all of the Avaya services in the
correct order. In this circumstance, it can be advisable to create a batch file which will delay the start of these services
until the PC is fully running.

Avaya IP Office Services can be started successfully at system start-up using a scheduled task that initiates the batch file
below. This batch file ensures that the services will start successfully and in the proper order.

1.  Set all Avaya services listed below to Manual start. Do not include Key Server.

2.Create the batch file below and save it to %SYSTEMROOT%. Only include lines for the services which are installed.

@echo off
rem Wait 60 seconds before execute.
timeout /t 60
net start Voicemail Pro Service

3.Create a scheduled task to start the batch file at system start-up.
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2.3 Upgrading Voicemail Pro
This section describes how to upgrade Voicemail Pro. The options available are:

· Upgrading from Voicemail Lite

· Upgrading from below Voicemail Pro 3.2

· Upgrade from 3.2 or higher

 

2.3.1 Upgrade from below version 3.2
It is important that the settings of an existing Voicemail Pro are exported before any upgrade. Although folders that
contain prompts and messages are not affected by the upgrade process, the editable version of a customer call flow is
lost.

To upgrade from below version 3.2 to version 4.x+:

1.Export the Database 
Before removing Voicemail Pro as part of an upgrade, you must create a backup copy of the call flow database. This will
contain any customizations made to the default call flow.

1.Start the Voicemail Pro Client.

2.From the File menu, select the option Import or Export.

3.Select the option Export call flows and click Next.

4.Enter a file path and file name ending in .mdb, for example C:\temp\backup.mdb. Click Next.

5.Click Finish to start the export then click Close to complete the export procedure.

6.Close the Voicemail Pro Client.

2.Back up the Registry 
Any registry settings that are associated with Voicemail Pro need to be backed up.

1.Insert the IP Office Applications DVD. Click on the link for Voicemail Pro and then double-click on setup.exe.
The Choose Setup Language window opens.

2.Right-click the DVD drive and select Open.

3.Locate the file backupreg.bat and double-click it to run the application. 

4.Check that the registry settings have been backed up.  The batch file should have created 3 backup files in the
Windows Temp directory. Make sure that the following 3 files exist in that location:

· VMPro.arf

· NetAly.arf

· IMSGateway.arf

3.Remove Voicemail Pro 
Any previous versions of Voicemail Pro must be removed before you start to install the new version.

1.Open the Windows Control Panel.

2.Select Add/Remove Programs.

3.Select IP Office Voicemail Pro and click Add/Remove.

4.From the options offered, select Remove and click Next.

5.Follow the prompts that you see on the screen during the removal process.

6.When the process has been completed, select the option Yes, I want to restart my computer now and click
Finish.

4.Restore the Registry 
The Voicemail Pro registry settings that were backed up in step 2 needs to be restored.

1.Insert the IP Office Applications DVD. Click on the link for Voicemail Pro and then double-click on setup.exe.
The Choose Setup Language window opens.

2.Locate the file restorereg.bat and double-click it to run the application. This restores the registry settings previously
associated with Voicemail Pro.

5.Install the New Software  
See Installing Voicemail Pro  and then refer to the sections that relate to the type of Voicemail Pro that you intend to
install.
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6.Restore the Database 
The copy of the call flow database that contained any customizations made to the default call flow needs to be restored.

1.Start Voicemail Pro.

2.From the File menu, select Import or Export. The Import or Export Call Flows window opens.

3.Select Import Call Flows.

4.Click Next.

5.Click the Browse button and locate the file that contains the backed up call flows.

6.Select the file and click Open.

7.In the Import or Export Call Flows window, click Next.

8.Click Finish to start importing the database.

9.Click Close to complete the import process.

10.Click on Save and Make Live to save the Call flows.

The new version of Voicemail Pro has been installed. Test that the system is running by dialing *17 from any extension.
You should hear the mailbox announcement.

 

2.3.2 Upgrade from Version 3.2+
You can directly upgrade versions of Voicemail Pro from Voicemail Pro 3.2 upwards. However we still recommend that you
follow the procedure for backing up the database before upgrading. 

To upgrade from version 3.2 or higher:

1.Insert the IP Office Applications DVD. Click on the link for Voicemail Pro and then double-click on setup.exe.
The Choose Setup Language window opens.

2.Select the installation language. The language selected is used for the installation.

3.Click OK. You are asked 'This setup will perform an upgrade of IP Office Voicemail Pro. Do you want to continue?' 

4.Click Yes. The Upgrading the IP Office Voicemail Pro window opens.

5.Click Next to start the upgrade. The setup status window opens. The progress of the upgrade is indicated by a time
bar. 

6.Click Finish. The Email settings window opens.

7.Enter your email account details and click Next. The SMTP Email settings window opens.

8.Enter your SMTP Email details and click Finish. The SMTP settings entered will be validated. If an error occurs, the
validating configuration window opens containing the SMTP Error .

9.Click Yes when asked if you want to start the Voicemail Pro service. 

10.The new version of Voicemail Pro has been installed. Test that the system is running by dialing *17 from any
extension. You should hear the mailbox announcement.

128
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2.3.3 Upgrade to Voicemail Pro
You can upgrade from Voicemail Lite to Voicemail Pro. The process described here assumes that Voicemail Pro is being
installed onto the same PC that previously hosted Voicemail Lite. The steps described here will remove Voicemail Lite but
will not remove the existing mailbox messages and greetings.

To upgrade from Voicemail Lite to Voicemail Pro:

1.Remove Voicemail Lite

1.Make sure that Voicemail Lite is not running. It might be necessary to close the Voicemail Lite server program.

2.Open the Windows Control Panel and select Add/Remove Programs.

3.Select IP Office Admin Suite and click Change. The Welcome to the Installshield Wizard for IP Office Admin Suite
window opens.

4.Click Next. The Program Maintenance window opens.

5.Select Modify and click Next.

6.In the list of selected Features, click the option Voicemail Lite and select This feature will not be available. The

feature Voicemail Lite will have a red cross by the name. .

· Important - Do not uncheck any other boxes as this will also remove those features.

7.Click Next. The Ready to Modify the Program window opens.

8.Click Install. The Voicemail Lite program will be removed, which may take several minutes.

9.Click Finish to exit the InstallShield Wizard.

10.Click Close to close the Add/Remove Programs window.

11.Remove any shortcuts to VMLite.exe from Start > Programs > Startup.

2.Install the New Software 
The next step is to install the Voicemail Pro software. See Installing Voicemail Pro  and then refer to the sections that
relate to the type of Voicemail Pro that you intend to install.

3.Move the Voicemail Lite Folders 
This must be done before users start to use Voicemail Pro. As part of the upgrade procedure you need to move the
Voicemail Lite folders that contain any existing voicemail messages and mailbox greetings. This stage copies the existing
Voicemail Lite messages and greetings over the newly installed Voicemail Pro set.

4.Using Windows Explorer or My Computer, locate the folder C:\Program Files\Avaya\IP Office\Voicemail Server.

5.Copy all sub-folders and files in that folder.

6.Paste the sub-folders and files in the folder C:\Program Files\Avaya\IP Office\Voicemail Pro\VM. Replace any
existing folders.

7.Select the Mailbox Mode. 
Voicemail Lite runs in IP Office mailbox mode. By default Voicemail Pro installs in Intuity mailbox mode. If required by
your users, you can set Voicemail Pro back to IP Office mailbox mode.

1.Start the Voicemail Pro Client.

2.Click the Preferences  icon and select General.

3.On the General tab, change the Default Telephony Interface from Intuity to IP Office.

4.Click OK.

5.Click  Save & Make Live.

The new version of Voicemail Pro has been installed. Test that the system is running by dialing *17 from any extension.
You should hear the mailbox announcement.

14
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2.4 UMS Web Services
Voicemail Pro 4.2+ adds support for user mailboxes to be accessed using the additional methods listed below. For
Voicemail Pro 5.0+ this has been expanded to include hunt group mailboxes. 

· IMAP Email Client Support
This method allows mailbox access using any email client that supports IMAP, for example Outlook and Lotus Notes.
The Voicemail Pro server PC acts as the IMAP server. 

· Web Voicemail Access
This method alls mailbox access using a web browser. Messages can be played back to an IP Office phone extension
or through the PC if the browser is audio enabled. Web voicemail requires the voicemail server to also run IIS and
PHP. 

· UMS Exchange 2007 (Voicemail Pro 5.0+)
A user or group can be configured to have their voicemail messages forwarded to the inbox of an Exchange 2007
email account. Telephone, including Visual Voice, mailbox access is redirected to that email inbox as the store for
voicemail messages. Alternatively the user can access their voicemail messages using Outlook 2007 or any other
mechanisms supported by Exchange 2007. Voicemail messages in an Exchange 2007 inbox are not visible to UMS
IMAP and UMS Web Voicemail, however Exchange 2007 provides its own methods for IMAP and web browsing of
Exchange mailboxes. 

Use of these options requires the user to be licensed, either using an appropriate IP Office user profile license or the
legacy UMS Web Services license. 

Feature Web
Voicemail

IMAP Client Exchange
2007

Playback via PC.

Playback via User Extension. [1]

Save message Wav to PC.

Forward messages to other voicemail
mailbox.

Forward messages to other email mailbox.

Undelete manually deleted messages.

Mark message as unread.

Change voicemail password.

Show Message Types Web
Voicemail

IMAP Client Exchange
2007

- New (Unread).

- Old (read).

- Saved.

- Priority.

- Private. [2]

- Deleted.

1.Exchange 2007 Unified Messaging supports the playback of messages through a range of options controlled and
configured on the exchange server. 

2.Private messages are not indicated, however the web voicemail will not allow the forwarding of private messages. 
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2.4.1 IMAP Installation
Voicemail Pro 4.2+ support mailbox synchronization with email clients that can support IMAP (Internet Message Access
Protocol) accounts. Examples are Outlook, Outlook Express and Lotus Notes. 

Once configured, the IMAP folder and the mailbox are synchronized whenever the IMAP folder is opened. The method of
indication of the different message types will depend on the email client being used and is not controlled by the Voicemail
Pro. 

The number of mailboxes that can be configured for IMAP and/or web access is controlled by licenses. 
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Installing the Voicemail Pro IMAP Server
The IMAP server is installed as a standard part of the Voicemail Pro service installation. It uses the IP address of the
Voicemail Pro server PC and runs on the standard IMAP port 143. 

The only special consideration is to avoid having any other IMAP server running on the same PC. 

Licensing IP Office for Web Services
UMS web services can be licensed in a number of ways by licenses added to the IP Office configuration: 

· User Licensing 
User licensing is done as follows. 

· Users whose Profile is set to Teleworker User or Power User can be enabled to UMS if required. This
requires Teleworker Profile or Power User Profile licenses. 

· User's whose Profile is set to Basic User can be licensed using legacy UMS Web Services licenses. 

· Hunt Group Licensing 
Hunt groups are licensed by UMS Web Services licenses. 

1.Start IP Office Manager. 

2.Receive the configuration from the IP Office associated with the Voicemail Pro server. 

3.In the  Licenses section, add the required licenses. 

4.Merge the configuration back to the IP Office and then receive the configuration again. 

5.In the  Licenses section check that the License Status of the licenses is now shown as Valid. 

6.Start the Voicemail Pro client

7.Select Help | About. 

8.The screen should list the Web Services as Started and should show the number of UMS licenses. 

Configure Users for UMS
1.Start IP Office Manager. 

2.Receive the configuration from the IP Office system hosting the user. 

3.Select  User and then select the required user. 

4.Set their Profile to either Teleworker or Power User. 

5.Select the Voicemail tab. Enable UMS Web Services. Click OK.

6.Merge the configuration back to the IP Office.

Configuring Hunt Groups for UMS
Access to hunt group mailboxes using UMS is supported for Voicemail Pro 5.0+. 

1.Start IP Office Manager. 

2.Receive the configuration from the IP Office system hosting the hunt group. 

3.Select the hunt group. 

4.Click on the Voicemail tab. 

5.Enable UMS Web Services. Click OK. 

6.Merge the configuration back to the IP Office. 
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Configuring a User Email account
The exact method of configuration of an IMAP account depends on the IMAP client being used by the user. For example it
may be necessary to enable some field with dummy data in order for the email client to accept the account even though
those settings are not used by the Voicemail Pro IMAP server. 

The general details that are required are: 

IMAP Account Setting IP Office Value

Incoming Server Voicemail Pro server IP address or domain name address. 

Account Name User name or extension number.

Password User voicemail code. 

Example: Outlook

1.Select Tools and then Options. 

2.Select Mail Setup and then click E-mail Accounts. 

3.Select Add a new e-mail account. 

4.Select IMAP as the server type. 

5.In Server Information for Incoming mail server and Outgoing mail server enter the IP address or domain
name address of the Voicemail Pro server PC. 

6.In Logon Information enter the user's extension number and voicemail code as the User Name and Password. 

7.Click Next. 

Example: Outlook Express

1.Select Tools and then Accounts. 

2.Select Add and then Mail. 

3.Enter a descriptive name such as Voicemail and click Next. 

4.Enter an email address. This is not used but a value must be entered to move to the next screen. Click Next. 

5.Set My incoming mail server is a to IMAP. 

6. In the Incoming server field enter the IP address or domain name address of the Voicemail Pro server PC. 

7.Enter a value in the Outgoing mail server field. This is not used but a value must be entered to move to the next
screen. Click Next. 

8.For Account Name enter the user's extension number or name in the IP Office configuration. 

9.For Password enter the user's Voicemail Code. 

10.Click Next and then Finish.
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2.4.2 Web Voicemail Installation
Voicemail Pro 4.2+ support web access to user mailboxes. Users are then able to play their messages, mark them as
saved or deleted, or forward messages to another mailbox. Playback is through an IP Office extension or through the
audio facilities of the PC. 

Web Voicemail Installation Requirements
The Web Voicemail component is selectable as part of a custom Voicemail Pro installation. Note the pre-requisites below
before doing the Web Voicemail installation. 

· o IIS Web Server
Must be installed on the voicemail server PC before the Voicemail Pro Web Voicemail component is installed. 

· o PHP
Web Voicemail uses PHP. If an existing PHP is not detected, the Voicemail Pro installation will install its own
PHP. 

· o Licenses 
The use of Web Voicemail and the number of users who can be configured to access it are controlled by the UMS
Web Services license entered in the IP Office configuration. 

UMS web services can be licensed in a number of ways by licenses added to the IP Office configuration: 

· User Licensing 
User licensing is done as follows. 

· Users whose Profile is set to Teleworker User or Power User can be enabled to UMS if required. This
requires Teleworker Profile or Power User Profile licenses. 

· User's whose Profile is set to Basic User can be licensed using legacy UMS Web Services licenses. 

· Hunt Group Licensing 
Hunt groups are licensed by UMS Web Services licenses. 

· o Computer Name\URL
The computer name is used as part of its URL on the network. Ensure that the name is set to something that
appropriately indicates its purpose and that can be used as part of the URL for the web server within the customer's
domain. 

· o Remove IMS
Voicemail Pro UMS is not supported on systems that are using Voicemail Pro IMS. IMS must be removed before
UMS can be selected for installation. 
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User and Browser Requirements
For users to access Web Voicemail they require a web browser that meets the following requirements: 

· o Javascript Enabled Web Browser
Web Voicemail is tested against the following browsers. Other browser may work so long as they support JavaScript
and CSS. 

· Internet Explorer V6 SP1 or higher. 

· Internet Explorer V7 or higher. 

· Mozilla Firefox V2.0.0.2 or higher.

· Opera V9.10 or higher. 

· PC Playback 
Browser access allows the selection of message playback either via an IP Office extension or through the web
browser. Avaya test browser playback using the following Windows media players: 

· Windows Media Player 10. 

· Windows Media Player 11. 

· Quick Time 7.4.

· VLC 0.8. 

· o User Name and Password
Once enabled for UMS Web Services in the IP Office configuration, to log on using Web Voicemail, the user will need
to know their Name and Voicemail Code as set in the IP Office configuration. Note that this is the Name and not
the Full Name. 

Voicemail Pro Software Installation with Web Voicemail Component
The Web Voicemail component is installed as part of a Custom Voicemail Pro installation. From the list of 

1.Verify that IIS is installed and running on the voicemail server PC. Check that it can be browsed from user PC's. 

· While the server can be browsed by IP address, the URL used by users will be based on the server's computer
name within the customer domain. Check that web server can be browsed from user PC's using the server's
computer name as part of the URL. If necessary change that name to accurately indicate its function. 

2.Insert the IP Office Applications DVD. Click on the link for Voicemail Pro and then double-click on setup.exe.
The Choose Setup Language window opens.

3.When asked for the type of Voicemail Pro install to perform, select Voicemail Pro (Full). 

4.On the next screen select Custom. 

5. In the list of components scroll down and select Web Voicemail. Do not change any of the other selections unless
you understand the requirements for those components. 

6.Follow the remainder of the installation process and allow the voicemail server to reboot when required. 

Licensing IP Office for Web Services
UMS web services can be licensed in a number of ways by licenses added to the IP Office configuration: 

· User Licensing 
User licensing is done as follows. 

· Users whose Profile is set to Teleworker User or Power User can be enabled to UMS if required. This
requires Teleworker Profile or Power User Profile licenses. 

· User's whose Profile is set to Basic User can be licensed using legacy UMS Web Services licenses. 

· Hunt Group Licensing 
Hunt groups are licensed by UMS Web Services licenses. 

1.Start IP Office Manager. 

2.Receive the configuration from the IP Office associated with the Voicemail Pro server. 

3.In the  Licenses section, add the required licenses. 

4.Merge the configuration back to the IP Office and then receive the configuration again. 
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5.In the  Licenses section check that the License Status of the licenses is now shown as Valid. 

6.Start the Voicemail Pro client

7.Select Help | About. 

8.The screen should list the Web Services as Started and should show the number of UMS licenses. 

Configure Users for UMS
1.Start IP Office Manager. 

2.Receive the configuration from the IP Office system hosting the user. 

3.Select  User and then select the required user. 

4.Set their Profile to either Teleworker or Power User. 

5.Select the Voicemail tab. Enable UMS Web Services. Click OK.

6.Merge the configuration back to the IP Office.

Configuring Hunt Groups for UMS
Access to hunt group mailboxes using UMS is supported for Voicemail Pro 5.0+. 

1.Start IP Office Manager. 

2.Receive the configuration from the IP Office system hosting the hunt group. 

3.Select the hunt group. 

4.Click on the Voicemail tab. 

5.Enable UMS Web Services. Click OK. 

6.Merge the configuration back to the IP Office. 

UMS Web Voicemail and ContactStore
It is possible to run ContactStore and UMS Web Voicemail on the same server PC. However some additional steps are
required following installation in order to allow browser access to both applications. 

1.Install UMS web voicemail. 

2.Install ContactStore. 

3.Reboot the server. 

4.Within services, stop the ContactStore service. 

5.Using a web browser access a voicemail mailbox using UMS web voicemail. 

6.Restart the ContactStore service. 

7.Both application should now be accessible via web browser. 
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Playback Control
UMS message playback through the web browser is tested and supported with the Windows Media Player. It may work
with other audio playback controls but will not have been tested. 

The following methods can be used to check that the audio playback is associated with the Windows Media Player. 

Firefox

1.Select Tools | Options | Applications or Tools | Options | Content | File Types | Manage. 

2. In the search box enter x-mplayer2. 

3.Check that the Action is set to Use Windows Media Player or Use Windows Media Player plug-in Dynamic
Link Library. 

Opera

1.Select Tools | Preferences. 
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2.Select Downloads and use the search box to find x-mplayer2. 

3.Check that the setting is set to Use plug-in and Windows Media Player Plug-In Dynamic Link Library. 

Internet Explorer

1.Internet Explorer uses the application associated with the wav file type for Windows. 

2.Select My Computer. 

3.Select Tools | Folder Options. 

4.Select File Types. 
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5.Locate and select the WAV extension type. 

6.Check that the details show Windows Media Player as the selected application for this file type. 
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2.4.3 Exchange 2007 Installation
A UMS user or group can be configured to have their voicemail messages forwarded to the inbox of an Exchange 2007
email account. They can then access their voicemail messages using Outlook 2007 and playback those messages on their
PC. Alternatively any other mechanisms supported by Exchange 2007 Unified Messaging can be used. Access to the
messages from an IP Office telephone is still supported, including Visual Voice. 

Voicemail messages in an Exchange 2007 inbox are not visible to UMS IMAP and UMS Web Voicemail, however Exchange
2007 provides its own methods for IMAP and web browsing of Exchange mailboxes. 

· Note 
When using an Exchange 2007 server as the message store for a user's voicemail messages, the voicemail server
will deliver messages to the Exchange server on completion of the recording. However, the presentation to Outlook
and back to the voicemail server for message waiting indication (MWI) and access via telephone is delayed by
Exchange server processing. The delay is typically 1 or 2 minutes. The same delay also applies to changes in the
message status that affect message waiting indication. 

The following are the pre-requisites for UMS Exchange 2007: 

· Exchange 2007 Server 

· The Exchange 2007 server must be configured with the Unified Messaging Server Role selected. 

· A Dial Plan must be created on the Exchange 2007 server. This can be a blank dial plan but it must exist. 

· Within the Exchange 2007 server settings for each mailbox, select Enable Unified Messaging. 

· Voicemail Pro 

· The Voicemail Pro server must be configured for MAPI based voicemail email . 

· The supported MAPI applications are Exchange 2007 and Outlook 2007. 

· IP Office 

· The user or hunt group must be licensed and enabled for UMS Web Services. 

· The user or hunt group's Voicemail Email mode must be set to Forward. 

50
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Exchange Server 2007 Unified Messaging Configuration
This is a simple overview of the minimum steps required. For full details refer to the Microsoft documentation. 

In order to support UMS Exchange Server 2007 operation, the Exchange Sever must be configured to include the Unified
Messaging Server Role. 

1.From the Windows Control Panel, select Program and Features. 

2.Select Microsoft Exchange Server 2007 and click Change. 

3.The wizard for changing Exchange Server setup is started. Click Next. 

4. In the Server Role Selection list check that Unified Messaging Server Role is one of the selected roles. Click
Next through the wizard and then Finish.
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Having enabled the Unified Messaging role on the Exchange Server, the role can be configured and enabled for the
mailboxes.

1.Select Start | Programs | Microsoft Exchange Server 2007 | Exchange Server Management Console. 

2.Expand the Server Configuration list. The Unified Messaging role should appear in the list. 

3.You need to create a Unified Messaging dial plan. 

a. Expand the Organization Configuration and select Unified Messaging. 

b.Select the UM Dial Plans tab and in the Actions list select New UM Dial Plan.... 

c. The New UM Dial Plan wizard will be started. 

d.Create a plan similar to the one shown above. The digits length is not important but must be matched later in
the process. The simplest option is to set it to match your IP Office extension number length. Click New and
then Finish. 

4.You now need to select which mailboxes the Unified Server role is available. 
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a.Expand the Recipient Configuration section and select Mailbox. 

b.Right click on the configuration settings used for general mailbox users and select Enable Unified
Messaging.... 

 

c. The wizard for the mailbox Unified Messaging settings is started. 

d.For the Unified Messaging Mailbox Policy click on Browse... and select the previously created dial plan. 
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e. Select Automatically generate PIN to access Outlook Voice Access. Click Next. 

f. Select Manually entered mailbox extension. Enter a number that matches the digit length that was
specified in the UM Dial Plan previously created. The actual number entered does not need to match an IP
Office extension, only the length is important. Select Next. 

g.Select Enable and then Finish. 
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2.5 Voicemail Email
Voicemail Email allows the voicemail server to provide a number of email functions: 

· Forward a Message to Email 
If the voicemail server is set to IP Office mailbox mode, mailbox users are able to manually forward an voicemail
message to their email. 

· Automatic New Voicemail Messages 
For all mailbox modes, users can use voicemail email to automatically have a message sent to their email whenever
they receive a new voicemail message. The email can be a simple alert or it can include a copy of the voicemail as
an attachment. 

· eMail Action 
With customized call flows, an eMail action can be used to send a caller's recorded voicemail message to a
specified email address.

· UMS Exchange 2007 
In conjunction with Exchange 2007 and Outlook 2007, users are able to use their Outlook inbox as their mailbox for
voicemail messages. 

Voicemail Email features requires the voicemail server to be configured for access to either an SMTP email server or to a
MAPI email server via a MAPI enabled email client program on the voicemail server PC.

· SMTP Installation  
This is an email standard supported by most email servers. It is the default email mode for the voicemail server. 

· MAPI Installation 
MAPI requires a MAPI compliant email client program to be installed on the Voicemail Pro server. Supported MAPI
clients are Outlook 2000, 2002, 2003, 2007. It also requires the Voicemail Pro service to be run using a user
account that is able to send emails via that MAPI client. 

· The exact method of integration between the voicemail server and the MAPI email client depends on whether
the voicemail server is part of a work group or a domain. This guide contains examples for both approaches. 

· The MAPI process described in this guide was based on Microsoft Windows 2000 Professional with Microsoft
Outlook 2000 and Microsoft Outlook Express 5.5. Steps may differ depending on the version of Windows and
email client used. 
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2.5.1 SMTP Setup

To configure the server SMTP email settings:

1.Start the Voicemail Pro Client.

2.Click  Preferences and select General.

3.Click the Email tab.

4.Ensure that there are no settings on the MAPI sub tab. 

5.Enter the SMTP settings on the SMTP Sender  sub tab. These are the settings that the voicemail server uses for
sending SMTP emails. 

· Logging 
If selected, SMTP logging  by the server is enabled. 
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· Servers 
This section is used to enter details of the SMTP server or servers to which the voicemail server send its messages. 
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To add a server, click on the . icon. To edit the server, click on the  icon. To delete a server entry, click on . 

· Mail Domain 
This field is used differently depending on whether it is the first entry in the list or not: 

· For the first server entry in the list: 
This is the default outgoing email settings. It also sets the mail destination domain on which the voicemail
server filters incoming messages (see below) and so is repeated on the SMTP Receiver  tab. 

· Messaging Between Voicemail Servers 
For messaging between voicemail servers, the first entry in the SMTP Sender list must be the one
configured and used. Each server uses the SMTP server service on the same server PC as the voicemail
service. For example a Windows based servers uses the SMTP email provided by the IIS on the same
server. The voicemail  service also uses the domain set to filter incoming SMTP mails received by the SMTP
server. For this to work, the domain entered should be the fully qualified name of the server on which the
voicemail server is running, for example vmpro1.example.com. Any incoming messages where the
recipient mail domain is not exactly the same as the specified domain are ignored. The recipient can either
by vmsyncmaster, vmsyncslave or the name or extension of a mailbox on the Voicemail Pro server, for
example Extn201@vmprocentral.example.com or 201@vmprocentral.example.com. 

· For subsequent entries: 
The domain specifies that these settings should be used for emails sent to the matching domain. The entry
must be a fully qualified name resolvable by DNS or an IP address.

· Server 
This specifies the IP address or fully qualified domain name of the SMTP server to which messages are sent. 

· For the first server entry in the list: 
Where messaging between voicemail servers is being used (central, backup and or distributed servers), the first
entry is used and will match the domain set above. 

· For subsequent entries: 
It will be the address of the email server that will handle emails for recipients other than another voicemail server
on the network. 

· Port Number 
This is port to which messages are sent, usually 25.

· Sender (Identifier)
Note that some servers will only accept emails from a specific sender or sender domain. If left blank, the voicemail
server will insert a sender using either the email address set for the voice mailbox user if set or otherwise using the
best matching name it can resolve from the IP Office. 

· Server Requires Authentication 
This check box indicates whether the connection to send SMTP messages to the mail server requires authentication
with that server. The authentication will typically be to the name and password of a mailbox account configured on
that server. 

· Account Name 
Sets the name to use for authentication.

· Password 
Set the password to use for authentication.

· User Challenge Response Authentication (Cram MD5) 
If this check box is selected, the name and password are sent using Cram MD5.

6.Click OK.

7.Click  Save and Make Live.
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2.5.2 MAPI Setup
2.5.2.1 Domain Member

Before you start to install the Voicemail Pro software, you must:

1. Create a Voicemail Domain Account .

2. Configure Outlook for Internet Mail .

 

You are then ready to install Voicemail Pro for MAPI Voicemail Email as a Domain Member. This involves the following key
stages:

1. Install the Voicemail Pro Software .

2. Switch Voicemail Pro to MAPI .

 

2.5.2.1.1  Creating a Voicemail Domain Account

1. Make sure that the PC that will be running the voicemail server is a member of the domain. To join the domain you
will need the use of a log account with administrative permissions on the domain as well as the server PC, consult
the domain administrator.

2. On the Exchange server:

· Create an account called Voicemail on the domain and an associated mailbox.

· Provide a secure password.

· Check the User Cannot Change Password and Password Never Expires boxes.

3. Log on to the voicemail server PC using a domain administrator account.

4. From the Control Panel, select Administrative Tools.

5. Select Computer Management | Local Users and Groups | Groups.

6. Double-click Administrators and select Add.

7. From the Look In list select the domain name.

8. In the Name window, locate and highlight Voicemail. Click Add followed by OK and OK to close.
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2.5.2.1.2  Configuring Outlook for VoiceMail Email

1. On the desktop, right-click the Outlook icon and select Properties.

2. On the General tab, select Add.

a. Select Microsoft Exchange Server.

b. Click Next.

c. In the Server field, enter the name of the Exchange Server.

d. In the Mailbox field, enter Voicemail.

e. Click Next.

f. When you are asked if you travel with this computer, select No.

g. Click Next.

h. Click Finish.

3. Highlight the MS Exchange Settings and click Properties.

a. Highlight Microsoft Exchange Server and click Properties.

b. Click Check name and ensure that the name is resolved.

c. If the name is resolved, select Apply.

d. Click OK, OK and Close to shut the mail settings.

4. Do not continue until the name has been resolved correctly with the Exchange Server. If the name is not resolved,
check the account details with the Exchange Administrator.

5. Open Outlook and select Yes to register Outlook as the default email application.

a. Select Tools > Options.

b. Click the Preferences tab.

c. Click Email Options.

d. Uncheck Save copies of messages in Sent Items folder.

· You might want this option selected during initial setup to aid troubleshooting. However due to the size of wav
file message attachments you should uncheck it after installation testing is completed.

6. Log on to the Voicemail Pro Server PC using the voicemail account.

7. From Outlook, send a message direct to an extension user.

8. If this message is received correctly, you can continue installing the Voicemail Pro software. See Installing the
Voicemail Pro Software .
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2.5.2.1.3  Installing the VoiceMail Pro Software

1. Log off and log back on using the Voicemail account and password.

2. Install the required Voicemail Pro software. 

3. When the installation process requests a User Name and Password for the Voicemail Pro service, enter the Voicemail
account details.

4. Restart the server PC when requested and log on using the Voicemail account.

5. When SMTP email details are requested, enter no values and ignore the error message following the SMTP check.

6. Start the Voicemail Pro Service .

7. Check that the basic voicemail services start and operate correctly.

8. Switch Voicemail Pro to MAPI .

2.5.2.1.4  Switching VoiceMail Pro to MAPI

By default, the Voicemail Pro server is configured for SMTP email mode. However, MAPI settings are entered it will switch
to MAPI mode. Some options are not available if you are working offline. You must be working online to use this feature. 

To select the server email mode

1.Start the Voicemail Pro Client.

2.Click  Preferences and select General.

3.Click the Email tab.

4.Select the MAPI sub tab. Set the settings to match a MAPI account already configured and able to send emails
from the MAPI client on the voicemail server. 

 

· Enable MAPI 
Selecting this option will switch the voicemail server to using MAPI for its email options rather than SMTP. 

· Profile 
This is used to select the MAPI email account the voicemail server should use to provide visibility to the email
account mailboxes for which it requires access. The profile must exist within the MAPI email client on the
server PC and must be useable by the Windows account under which the Voicemail Pro service is running.

5.Click OK.
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6.Click  Save and Make Live.
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2.5.2.2 Work Group Member

Before you start to install the Voicemail Pro software, you must:

1. Create a Voicemail User Account .

2. Configure Outlook Express for Internet Mail .

3. Configure Outlook for Voicemail Email .

4. Configure Outlook for Exchange Server .

The user name and password created are requested as part of the installation of the Voicemail Pro service. The process
described here assumes that Outlook is installed but has not been previously used or configured.

You are then ready to install the Voicemail Pro software. See Installing the Voicemail Pro Software .

By default, Voicemail Pro is set to use SMTP for emails. You need to change this to MAPI. See Switching Voicemail Pro to
MAPI .

You also need to set the SMTP Email Account settings on the Voicemail Pro so that they match those of the customer's
email server. See Changing SMTP Email Account Settings .

 

2.5.2.2.1  Installing VoiceMail Pro for MAPI VoiceMail Email as a Work Group Member

Before you start to install the Voicemail Pro software, you must:

1. Create a voicemail user account. See Creating a Voicemail User Account .

2. Configure Outlook Express for Internet Mail. See Configuring Outlook Express for Internet Mail .

3. Configure Outlook for internet mail. See Configuring Outlook for Voicemail Email .

4. Configuring Outlook for exchange server. See Configuring Outlook for Exchange Server .

The user name and password created are requested as part of the installation of the Voicemail Pro service. The process
described here assumes that Outlook is installed but has not been previously used or configured.

You are then ready to install the Voicemail Pro software. See Installing the Voicemail Pro Software .

By default, Voicemail Pro is set to use SMTP for emails. You need to change this to MAPI. See , Switching Voicemail Pro to
MAPI .

You also need to set the SMTP Email Account settings on the Voicemail Pro so that they match those of the customer's
email server. See  Changing SMTP Email Account Settings .

 

2.5.2.2.2  Creating a Voicemail User Account

To create a Voicemail User Account

1. Log on to the server PC as the local administrator and create a new user. For this example the name of the user
account created used is Voicemail.

2. Set a secure password.

3. Clear User must change password at next logon and check Password never expires.

4. Click Create and then Close.

5. Right-click the New Account, and select Properties.

6. Select the Member Of tab.

7. Click Add.

8. In the Select Groups window, highlight Administrators and click Add. Click OK.

9. Continue with one of the following as appropriate to the installed MAPI client and method for sending email.
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2.5.2.2.3  Configuring Outlook Express for Internet Mail

To configure Outlook Express for Internet Mail

1. Click the Outlook Express icon to start the Configuration wizard.

2. In the Display name box enter Voicemail.

3. Click Next.

4. Select I already have an e-mail address that I'd like to use and enter the address in E-mail address, eg.
voicemail@example.com. Click Next.

5. Enter the name or address of the Incoming mail server and the Outgoing mail server. Note, if you enter the name,
you must ensure that the voicemail PC has the correct IP address of the DNS Server configured.

6. Click Next.

7. Enter the email account name and password, for example Voicemail. Select Remember password.

8. Click Next.

9. Click Finish to complete the wizard.

10. Open Outlook Express and select Tools > Options.

11. Click the General tab.

· Uncheck Send and Receive messages at Start up.

· Uncheck Check for new messages every.

12. Select the Send tab.

· Uncheck Save copy of sent messages in the 'Sent Items' folder.

· Check Send messages immediately.

· Under Mail Sending Format select Plain Text.

13. Click OK.

14. Log on to the server PC using the account that will be used for the Voicemail Pro server.

15. From Outlook or Outlook Express, send a message direct to an extension user.

16. If this message is received correctly, continue with installing the Voicemail Pro software.
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2.5.2.2.4  Configuring Outlook for Internet Mail

For the installation of Outlook to work correctly, the following setup process must be followed. Outlook can be configured
in two ways. Using the Wizard, prior to completing the steps below will cause Outlook not to send the messages correctly.

To configure Outlook for Internet Mail:

1. Right-click the Outlook icon on the desktop and select Properties.

2. Select Add.

3. Select Internet Email and click OK.

4. For the Mail Account, enter Voicemail.

5. For User Information enter Voicemail as the Name and for the Email address enter your address, for example.
voicemail@example.com.

6. Select the Servers tab. Enter the name or IP address of the Outgoing mail server and Incoming mail server.

7. The Incoming Mail Server details can be left blank as Outlook does not need to check for mail. Otherwise, enter
the account name and password for example, Voicemail. Select Remember password.

8. Select the Connection tab. Select Connect using my local area network (LAN). Click Next.

9. Click OK.

10. Click Next.

11. Accept the default path for file creation.

12. Select Next, then Finish and then Close.

13. Open Outlook.

14. On the Email Service Option Screen, select Internet Only.

15. Click Next.

16. Select Yes to register Outlook as the default email application.

17. Select Tools > Options.

18. Click the Preferences tab.

19. Click Email Options.

20. Uncheck Save copies of messages in Sent Items folder.

· You might want this option selected during initial setup and troubleshooting. Due to the size of wav file
message attachments it is advisable to uncheck it after installation is complete.

21. Log on to the server PC using the account that will be used for the Voicemail Pro server.

22. From Outlook or Outlook Express, send a message direct to an extension user.

23. If this message is received correctly, continue with installing the Voicemail Pro software.
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2.5.2.2.5  Configuring Outlook for Exchange Server

This option may be configured if Outlook is to be configured to connect to the Exchange Server, using a valid user name
and password, while the Voicemail PC remains a member of a work group.

To configure Outlook for Exchange Server:

1. Create a new mailbox on the Exchange Server, for example Voicemail, and assign it the same password as has
been configured on the voicemail PC.

2. Clear User must Change password at Next Logon and select Password Never Expires.

3. On the voicemail PC, logon with the Voicemail account.

4. Right-click the Outlook icon on the desktop and select Properties.

5. Select Add.

6. Highlight Microsoft Exchange Server and click OK.

7. Type in the Microsoft Exchange Server name and enter Voicemail in the Mailbox field.

8. Highlight the MS Exchange Settings, Click Properties.

9. Highlight Microsoft Exchange Server. Click Properties.

10. Click Check name and ensure the name is resolved.

11. If the name is resolved, select Apply. Click OK, OK and Close to shut the Mail settings.

12. Do not continue until the name has been resolved correctly with the Exchange Server. If the name is not resolved,
check the account details with the exchange administrator.

13. Open Outlook and select Yes to register Outlook as the default email application.

14. Select Tools > Options.

15. Choose the Preferences tab. Click Email Options.

16. Uncheck Save copies of messages in Sent Items folder.

· You may want this option selected during initial setup and troubleshooting. Due to the size of wav file message
attachments deselect it once installation is complete.

17. Log on to the server PC using the account that will be used for the Voicemail Pro server.

18. From Outlook or Outlook Express, send a message direct to an extension user.

19. If this message is received correctly, continue with installing the Voicemail Pro software.

2.5.2.2.6  Installing the VoiceMail Pro Software

1. Log off and log back on using the Voicemail account and password.

2. Install the required Voicemail Pro software. 

3. When the installation process requests a User Name and Password for the Voicemail Pro service, enter the Voicemail
account details.

4. Restart the server PC when requested and log on using the Voicemail account.

5. When SMTP email details are requested, enter no values and ignore the error message following the SMTP check.

6. Start the Voicemail Pro Service .

7. Check that the basic voicemail services start and operate correctly.

8. Switch Voicemail Pro to MAPI .

2.5.2.2.7  Switching VoiceMail Pro to MAPI

By default, the Voicemail Pro server is configured for SMTP email mode. However, MAPI settings are entered it will switch
to MAPI mode. Some options are not available if you are working offline. You must be working online to use this feature. 

To select the server email mode

1.Start the Voicemail Pro Client.

2.Click  Preferences and select General.

3.Click the Email tab.

4.Select the MAPI sub tab. Set the settings to match a MAPI account already configured and able to send emails
from the MAPI client on the voicemail server. 
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· Enable MAPI 
Selecting this option will switch the voicemail server to using MAPI for its email options rather than SMTP. 

· Profile 
This is used to select the MAPI email account the voicemail server should use to provide visibility to the email
account mailboxes for which it requires access. The profile must exist within the MAPI email client on the
server PC and must be useable by the Windows account under which the Voicemail Pro service is running.

5.Click OK.

6.Click  Save and Make Live.
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2.5.2.2.8  Changing SMTP Email Account Settings

To change SMTP Email Account Settings:

1. Open the Windows Control Panel.

2. Select  IP Office Voicemail Pro.

3. Select the SMTP Email Settings tab. 

4. Enter the settings to match the customer's email server and the email account configured on that server for the
Voicemail Pro service.

5. Click the Email Settings tab. 

6. Enter the email address for the account setup on the customer's email server for the Voicemail Pro service.

7. Click Check to test the connection to the specified email account.

8. Click OK. 
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2.5.3 Voicemail Email Operation
2.5.3.1 User and Group Configuration

The email address for each user and hunt group is set through the IP Office configuration.  

· Voicemail Email: Default = Blank (No voicemail email features) 
This field is used to set the user or group email address used by the voicemail server for voicemail email
operation. When an address is entered, the additional Voicemail Email control below are selectable to configure
the type of voicemail email service that should be provided. 

· Use of voicemail email requires the voicemail pro server to have been configured to use either a local MAPI
email client or an SMTP email server account. See Voicemail Email Installation . 

· The use of voicemail email for the sending (automatic or manual) of email messages with wav files
attached should be considered with care. A one-minute message creates a 1MB .wav file. 

· Voicemail Email Default = Off
If an email address is entered for the user or group, the following options become selectable. These control the
mode of automatic voicemail email operation provided by the voicemail server whenever the voicemail mailbox
receives a new voicemail message. 

· Users can change their voicemail email mode using visual voice. If the voicemail server is set to IP
Office mode, user can also change their voicemail email mode through the telephone prompts. The
ability to change the voicemail email mode can also be provided in a call flow using a Personal
Options Menu action or a Generic action. 

· If the voicemail server is set to IP Office mode, users can manually forward a message to email. 

· Off
If off, none of the options below are used for automatic voicemail email. Users can also select this mode
by dialing *03 from their extension. 

· Copy
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, a copy of
the message is attached to an email and sent to the email address. There is no mailbox synchronization
between the email and voicemail mailboxes. For example reading and deletion of the email message does
not affect the message in the voicemail mailbox or the message waiting indication provided for that new
message. 
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· Forward
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, that
message is attached to an email and sent to the email address. No copy of the voicemail message is
retained in the voicemail mailbox and their is no message waiting indication. As with Copy, their is no
mailbox synchronization between the email and voicemail mailboxes. Users can also select this mode by
dialing *01 from their extension. 

· UMS Exchange 2007
Voicemail Pro 5.0+ supports voicemail email to an Exchange 2007 server email account. For users and
groups also enabled for UMS Web Services this significantly changes their mailbox operation. The
Exchange Server inbox is used as their voicemail message store and features such as message waiting
indication are set by new messages in that location rather than the voicemail mailbox on the voicemail
server. Telephone access to voicemail messages, including Visual Voice access, is redirected to the
Exchange 2007 mailbox. See UMS Exchange 2007 Installation  and UMS Exchange 2007. 

· Alert
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, a simple
email message is sent to the email address. This is an email message announcing details of the voicemail
message but with no copy of the voicemail message attached. Users can also select this mode by dialing 
*02 from their extension. 

2.5.3.2 How Voicemail Email Messages Look

Messages sent by a user or group's voicemail email settings contain the following:

· To 
The user/group email address.

· From 
The name and address setting of the email client account.

· Subject 
Voicemail Message ('calling number' > 'user name') From:'calling number'.

· Body 
If the user or group's Voicemail Email mode is set to Copy or Forward, the message body will contain "IP Office

Voicemail redirected message".

· Attachment 
When using Copy or Forward mode, the message is attached as a wav file.

 

Messages sent via a Voicemail Pro eMail action are configurable, see The Voicemail Pro eMail Action .
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2.5.3.3 The Voicemail Pro Email Action

The  eMail action in Voicemail Pro can be used to send messages via email in response to caller actions in the
voicemail call flow. The action can also attach a wav file.

In the example above, the eMail action follows a Voice Question action. The $ in the eMail action's Attach file to
email field instructs it to use the file recorded by the preceding Voice Question action.

The same method can be used with a Leave Mail action. Note however that the Leave Mail action must be set to a valid
target mailbox which will then have a copy of the message.

Alternatively, the eMail action can attach a prerecorded wav file by specifying the file name. That named file can be
created by an Edit Play List action.
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2.6 Text to Speech (TTS) Installation
The Voicemail Pro server is able to use Text to Speech (TTS) in the following ways:

· Speak text in call flows using the  Speak Text action. The text can include variables passed from other actions
including database actions. 

· When installed in parallel with Voicemail Email , TTS can be used to provide email reading  to selected
mailbox users.

· TTS can be used by the Voicemail Pro client user to record prompts used by call flow actions. 

TTS Licensing
Voicemail Pro TTS requires the server PC to have a Microsoft SAPI 5 compatible TTS engine installed and a valid license
entry. 

· Email Reading 
This feature is supported by the Voicemail Pro server's standard Preferred Edition license. Users who want to use
this feature must have their user profile configured as either Mobile User or Power User using Mobile User
Profile or Power User Profile licenses. 

· Speak Text Actions / Prompt Recording 
The license for this operation depend on whether you will be using the Avaya supplied ScanSoft TTS speech engines
or a 3rd party generic TTS speech engines (including the TTS speech engines included in Microsoft operating
systems). 

· Generic TTS 
The use of up to 8 simultaneous generic TTS ports is enabled by the Advanced Edition license. Alternatively
separate VMPro TTS (Generic) licenses can be added. 

· Avaya ScanSoft TTS 
The use of the Avaya supplied ScanSoft TTS engines is licensed by the addition of VMPro TTS (ScanSoft)
licenses to the IP Office configuration. 

If both generic TTS and ScanSoft TTS licenses are added, both TTS engines will be used for calls on a first-come first-
served basis. The TTS engine used for particular calls cannot be controlled. Therefore we recommend that only one type of
TTS engine is licensed within a system.

Languages
For Voicemail Pro 5.0 and higher, the supplied ScanSoft TTS software now supports the same set of languages as
Voicemail Pro speech prompts except for Hungarian. If more than one TTS language is installed, a Select System
Prompt Language action can then be used to switch TTS to a different language from the selected default. 

· Installation on Windows Server Operating Systems
On many Windows server PC's, while the Windows Audio components are present by default they are not always
enabled. If this is the case the playback of voice prompts may be 'choppy' and the TTS (if installed) will not work.
However, enabling Windows Audio does not require the server PC to have a sound card installed. 

1.Ensure that you have full administrator rights for the PC. This process will also require the PC to be restated. 

2.In the Windows Control Panel select Sounds and Audio Devices. 

3. If Windows Audio has not been enabled, select the Enable Windows Audio check-box. 
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2.6.1 Installing Generic Text to Speech

To install Text to Speech:

1.Install and test Voicemail Pro as normal.

2.Using IP Office Manager, add the Advanced Edition or VMPro TTS (Generic) license into the IP Office
configuration. Send the new configuration to the IP Office system.

3.Reload the IP Office configuration into IP Office Manager and check that the status of the license has changed to 
Valid.

4.The Voicemail Pro installation includes the default Microsoft TTS engines (Microsoft Sam, Mike, Mary and Simplified
Chinese) as standard. If another third-party SAPI 5 compatible TTS engine is going to be used, install that software.

5.If the system is licensed for generic TTS, Voicemail Pro will automatically discover any SAPI 5 installed engine. If
there is no 3rd party engine installed then the Microsoft 3rd party engine is used.

 

2.6.2 Installing Avaya Text to Speech
The Avaya TTS engine for Voicemail Pro is supplied on separate DVD's (x2) from the Voicemail Pro software . 

To install Avaya Text to Speech:

1.Install and test Voicemail Pro as normal. 

2.Using IP Office Manager, add the VM Pro TTS (ScanSoft) license into the IP Office configuration. Send the new
configuration to the IP Office system. 

3.Reload the IP Office configuration into IP Office Manager and check that the status of the license has changed to 
Valid.

4.Insert the first Avaya TTS DVD. The installation should auto-start.

5.Follow the prompts and install the required languages. 

6.If the system is licensed for Avaya TTS, the ScanSoft engine is automatically used.

 

2.6.3 Setting Up Text To Speech to Read Email

In conjunction with MAPI email clients and Exchange server, TTS can be used to read new e-mails in a user's email inbox
when they access their voicemail mailbox. 

· The Voicemail Pro server must have been installed and configure to support voicemail email using a MAPI client
. 

· Email reading can only be enabled for IP Office users whose Profile setting is set to Mobile User or Power User. That
requires the IP Office to have Mobile User Profile or Power User Profile licenses. 

· This feature is supported only for Intuity mode. Users hear their new voicemail messages and then the number of
"Messages with text". Before each email is spoken, details of who it is from, when the message was sent and the
size are given. This allows large or non-urgent e-mails to be skipped.

· Email reading cannot be used for e-mails in HTML format. If HTML messages are received, all of the code will be
read out as a message.

1.Within the IP Office configuration, display the settings for the user. 
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2.On the User tab, set the user's Profile to either Mobile User or Power User. 

3.On the Voicemail tab 

· Voicemail Email 
Enter the user's email address. 

· Voicemail Email Reading 
Enable this option for TTS email reading. 
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2.7 Troubleshooting
2.7.1 Checking the Voicemail Pro Service
If Voicemail Pro has been installed successfully, if the server PC has been rebooted then the voicemail service is started
automatically. However it is useful know how to check the services and to manually restart them if necessary.

To check/restart the Voicemail Pro Service:

1. Open the Windows Control Panel.

2. Select Administrative Tools > Services. 
 

3. The Voicemail Pro Service should be visible. Its Status should be Started and the Startup Type should be set
to Automatic. Other services may be present depending on the Voicemail Pro options installed. The possible
services are: 

· Voicemail Pro Service
This is the main Voicemail Pro service. Normally this is the only service that needs to be stopped and
restarted. It will stop and restart the other services that it uses.

4. Close Services.

Setting the Voicemail Services or PC to Restart Automatically
The following action is optional. If there is some fault causing the Voicemail Pro service to halt, that fault should be
investigated and fixed, however having the service or PC automatically restarted if possible will minimize the disruption to
the Voicemail Pro users. 

1.Use the Windows control panel to select the Voicemail Pro Service. 

2.Right-click on the service and select Properties. 

3.Select the Recovery tab. 

4.Use the options presented to either restart the service and or restart the PC should the operating system detect
that the Voicemail Pro service has halted. 
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Using a Batch File to Start Services 
In some instances, certain computers might not respond quickly enough in order to start all of the Avaya services in the
correct order. In this circumstance, it can be advisable to create a batch file which will delay the start of these services
until the PC is fully running.

Avaya IP Office Services can be started successfully at system start-up using a scheduled task that initiates the batch file
below. This batch file ensures that the services will start successfully and in the proper order.

1.  Set all Avaya services listed below to Manual start. Do not include Key Server.

2.Create the batch file below and save it to %SYSTEMROOT%. Only include lines for the services which are installed.

@echo off
rem Wait 60 seconds before execute.
timeout /t 60
net start Voicemail Pro Service

3.Create a scheduled task to start the batch file at system start-up.
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2.7.2 Voicemail Pro User Log
User authentication failures are logged in the event viewer, under VMPro User Log. The following details are logged:

· UserID

· Tool name

· IP address of the Client trying to log in.

 

To view the log details:

1.From the Control Panel, select Administrative Tools > Computer Management. The Computer Management
window opens.

2.In the System Tool directory, view the Event Viewer.

3.Click VMPro User Log to view the details.
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2.7.3 Tracing in Debug
Many applications, including Voicemail Pro, output activity messages that are viewable in Debug View (DbgView). This
application can be downloaded from http://marketingtools.avaya.com/knowledgebase/tools/debug.

 

Installation

1.Download the zip file.

2.Unpack the files into a folder such as c:\debug on the server PC. 

3.Run DbgView.exe.

4.Events are shown in the DbgView window. These can be logged to a file if required. The level of detail shown can be
filtered to show more or less activity.

 

Logging

1.Run DbgView.exe.

2.Select File | Log Preferences. 

3.Set the logging details are required and click OK.

4.While DbgView is running the viewable trace is also copied to the specified file.

5.The debug log files can be opened in programs such as WordPad. 
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Filtering

1.Select View | Debug Filters.

2.Select the module for which you want to increase/decrease reporting.

3.In the right hand panel adjust the level of reporting.

4.Close the Configure Debug Filters window.

2.7.4 The Voicemail Console
The voicemail console mode (that is running as the voicemail service in Interact with desktop mode) is no longer used.
Running services in this mode is not supported by Microsoft on Vista or Server 2008. 

Instead you should use the debug viewer  to view voicemail server activity as it occurs.69
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3. Linux Server Installation
A Voicemail Pro server is one of the Linux components installable as part of the IP Office Application Server DVD
installation. That process is covered separately in the IP Office Application Server documentation. 

· The license requirements  on the IP Office system for supported voicemail features are the same. 

· Configuration of the IP Office configuration  settings for voicemail is not affected by whether the server is
Windows or Linux based. 

· Configuration of the voicemail server setting is still done using the Windows based Voicemail Pro client application.
The client can be downloaded from the Linux server for installation on a Windows client PC. 

Mixing Linux and Windows Servers
In scenarios where multiple Voicemail Pro servers are used, see Centralized Voicemail Pro, a mix of Linux and Windows
based servers can be used. 

Linux Server Feature Support
For a Voicemail Pro 7.0 server running on a Linux based server, the following Voicemail Pro features are currently not
supported: 

· VB Scripting.

· TTS Text to Speech. 

· MAPI Email. 

· UMS Exchange Integration. 

· UMS Web Voicemail (IMAP or one-X Portal are available as alternatives). 

· 3rd Party Database Integration.

· VPNM.

· ContactStore for IP Office.

When logged into the voicemail server using the Voicemail Pro client, those features not supported are grayed out or
hidden. If those features are present in an imported call flow, they will not function and calls attempting to use those
features will be disconnected. 

For Small Community Network scenarios where multiple voicemail servers are present, for example distributed and backup
server, a mix of Linux based and Windows based servers are allowed. 
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Chapter 4.
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4. Using the Voicemail Pro Client
The Voicemail Pro client is used to administer the Voicemail Pro server. This section covers the basic operation of the
Voicemail Pro client to connect to a Voicemail Pro server. Full details of administration using the client are covered in the
"IP Office Voicemail Pro Administration" manual. 

For a Windows based server, the client can be installed on the same server and used locally to administer the server. The
client can also be installed separately on another Windows PC and then be used to remotely administer the server. 

For a Linux based server, the client must be installed on a separate Windows PC and then be used to remotely administer
the server. 

4.1 Logging in to the Voicemail Pro Server
If you start the Voicemail Pro client on the same computer as the voicemail server, it will assume that you wish to
manager the server and will automatically load its settings. You will have full access to all the servers settings, you do not
need to login with an administrator account name and password. 

To connect to a remote voicemail server you will need to login using the name and password of an administrator account
already configured on that server. The default account is Administrator and Administrator. After logging in with this
account you should change the password from that default value. 

To Start the Voicemail Pro Client
1.From the Start menu, select Programs | IP Office | Voicemail Pro Client. 

2.The Voicemail Pro Client window opens. 

· If the client has been started before, it will attempt to start in the same mode as it previously used. If it cannot
do that or it is the first time the client has been started, the select mode menu is displayed. 

· Select either of the Offline modes in order to import and export voicemail call flow and module files without
being connected to any voicemail server. In the Offline mode for Linux, those call flow options not supported
by a Linux base voicemail server are grayed out. 

· To connect to a voicemail server select Online. 

· Enter the name and password for an administrator account on the voicemail server. 

· Note that these are not required is accessing a voicemail server on the same PC as the client. 
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· The default account is Administrator and Administrator. After logging in with this account you
should change the password from that default value.

· If 3 unsuccessful logins are attempted using a particular administrator account name, the account is
locked for an hour. 

· In the Unit Name\IP Address field enter the DNS name or IP address of the voicemail server. 

· Alternatively click on Browse to search the local network for a server and select a server from the
results. 

3.If connection to a remote server, the following menu may appear. If you select Download, any existing call flow you
may have loaded in the client will be overwritten. For more details see Callflow Download . 

4.If this is the first time that the voicemail server has been logged into, you should first change the default remote
access account. 

· If you logged in remotely using the default account, select File | Change Password. 

· If you logged in locally, select Voicemail Pro Administrators in the navigation panel.dd

76



Voicemail Pro Installation Page 76
- Issue 01a (01 May 2011)IP Office Release 7.0

4.2 Confirm Call Flow Download Window
When you connect to a server across a LAN or WAN to view or modify the call flow on the server, a check is made to see if
the call flow that is stored locally on the client is the same. The call flow on the server might be different to the call flow on
the client because:

· The local call flow is older than the version on the server, for example if the call flow on the server has been
modified by another Client connection.

· The local call flow is newer than the version on the server, for example if the call flow on the server has been
worked on while the local Client was being used in offline mode.

· The local call flow is from a different server, for example if you are connecting to a different server to the one from
which the call flow was previously downloaded.

If the call flow is the same, no data will need to be copied from the server to the client. If the call flow is different you can
chose to download the call flow from the server or to use the local call flow.

· Download 
Click to download the call flow from the server.

· Cancel 
Click this if you do not want to download the call flow from the server.

To upload the local call flow to the server, use the Save or Save and Make Live options from the File menu. See Saving
Changes and Making them Live .

4.3 Continue Offline Message Window
Only one Voicemail Pro client can be connected to a voicemail server at any time. To avoid access to the server being
blocked by a session of Voicemail Pro client that has been left connected, a Client/Server Connection Timeout (mins)
setting is used to disconnect idle client session. By default the timeout is set to 5 minutes. 

If your Voicemail Pro client session has timed out, the Voicemail Pro client will prompt you whether it should attempt to re-
establish the session or close. You are then able to continue working in offline mode or to close the client. 
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4.4 Saving Changes and Making them Live
The call flow settings shown and edited using the Voicemail Pro client are stored in a database file (Vmdata.mdb) on the
voicemail server. However, when edited, the changes are not automatically applied to the operation of the voicemail
server. Instead the database file must be converted to a separate file (Root.vmp), that being the file that is used by the
voicemail server for its current operation. 

To Save the Configuration and Make It Live

1.Choose  Save & Make Live to save the settings as the Root.vmp file used by the voicemail server. 

· If you are working remotely in Offline mode, you will be prompted to select whether to save your changes to
the local database or to the remote server. 

To Save the Configuration to a File Without Making It Live
Call flow settings can be saved to a .vmp file and then included in the operation of another voicemail system. 

1.Choose  Save as to save the database as a .vmp file with the name that you specify. You can then copy the file
to other systems.

4.5 Logging Out
It can be useful to connect to a system to download the current system configuration and then disconnect and make
changes offline. You can then test configuration changes offline before applying them to a live system.

· Logging out is not the same as closing down with the Exit option. See Closing Down .

· If the Client and Server are installed on the same machine, the Log Out option is not available.

To Log Out
1.From the File menu, select Log Out. 

2.You are logged out of the Voicemail Pro server and placed in offline mode. You can either make configuration
changes offline and then log back in when you are ready or log on to a different server to work. See Logging in to
the Voicemail Pro Server .

4.6 Closing Down
When you have finished working, you can close down the Voicemail Pro Client. 

To Close the Voicemail Pro Client
1.From the File menu, select Exit.

2.If you have not made any changes, the Voicemail Pro Client closes and you are returned to the desktop. If you have
made changes, a message is displayed to ask whether you want to save them.

3.If you do not want to save your changes, click No. No changes are saved. If you want to save your changes, click
Yes. Your changes are saved but not yet made live.

4.If you are ready to make your changes live, click Save & make Live. 

77

74





Voicemail Pro Installation Page 79
- Issue 01a (01 May 2011)IP Office Release 7.0

IP Office Configuration

Chapter 5.
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5. IP Office Configuration
The default IP Office configuration settings allow almost immediate voicemail operation as soon as a voicemail server is
running on the LAN. Those default settings are:

· Voicemail running on a PC accessible by the IP Office using a broadcast address of 255.255.255.255.

· Voicemail on for each user and hunt group on.

· No Voicemail Code set for any mailboxes. Until a code is entered for a mailbox, it can only be accessed from the
user's own extension.

· No Voicemail Email or Voicemail Help operation.

· No Voicemail Reception numbers set for user mailboxes.

· Hunt group mailboxes are created and used by default but there is no default message waiting indication or method
for collecting messages. A method for accessing each hunt group mailbox should be programmed. 
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IP Office Configuration:  

5.1 User and Group Mailboxes
The voicemail server creates mailboxes based on the user and hunt group names that are entered in the IP Office Manager
application. Whenever the Voicemail Pro is restarted or the IP Office configuration is changed, new mailboxes are created
for any new names that are found.

This method of operation has the following consequences:

· Mailboxes are based on names 
For all users and groups, if their name is changed or deleted, they are no longer associated with their former
mailbox and any associated Voicemail Pro start points.

· Voicemail is case sensitive 
If a mailbox or start point name is entered incorrectly in IP Office Manager or Voicemail Pro, the intended operation
will not occur and the call may be disconnected.

· Voicemail removes spaces at the end of mailbox names 
If spaces are left at the end of a mailbox user's name in IP Office Manager, when the mailboxes are created, the
space at the end of the name is dropped. When this occurs the mailbox cannot be found as there is a mismatch
between the user name and directory. 
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5.2 System Settings
The IP Office can work with several different types of voicemail server. Therefore it is important to check that it is
configured for operation with Voicemail Pro. 

1.In IP Office Manager, select System.

2.Click the Voicemail tab. 

· Voicemail Type 
Specifies the type of voicemail system the IP Office is configured to work with. Unless detailed otherwise, the
option Voicemail Lite/Pro should be used with Voicemail Pro server. Additional options are displayed
depending on the selected voicemail type. 

· Centralized Voicemail  
This setting is used for remote systems in a Small Community Network where the central voicemail server
is being hosted by another IP Office. The Voicemail Destination field below is used to enter the
Outgoing Group ID of the SCN trunk to the IP Office hosting the central voicemail server. 

· Distributed Voicemail  (Software level = IP Office Release 6)
This option is used in a Small Community Network for remote IP Offices which want to be associated with
their own voicemail server in addition to the central voicemail server. The IP Office will require licenses for
Voicemail Pro operation and for the voicemail features required. The Voicemail IP Address below is used
to enter the IP address of the IP Office's voicemail server while the Voicemail Destination field below is
still used to set location of the central voicemail server as for centralized voicemail. 

· Embedded Voicemail 
Not used with Voicemail Pro. 

· Group Voicemail 
Not used with Voicemail Pro. 

· Remote Audix Voicemail 
Not used with Voicemail Pro. 

· Voicemail Lite/Pro 
This is the normal setting used for Voicemail Pro. 

· Voicemail IP Address 
By default the IP Office connects to the Voicemail Pro server by using the address 255.255.255.255 to
broadcast for any server on the same LAN as itself. When it receives a response it will use that voicemail
server. However it may be necessary or desired to set this access to an exact address. Change the default
address (255.255.255.255) to the IP address of the PC on which the Voicemail Pro server is running. 

· For configuration of IP Office systems using centralized Voicemail Pro in an IP Office Small Community
Network (SCN) see Centralized Voicemail Pro . 

· Message Button Go To Visual Voice 
Many Avaya phones have a fixed button labeled MESSAGES which can be used by the phone user to access
their mailbox. If this option is selected, then on phones able to support Visual Voice, visual voice is used when
the button is pressed rather than the standard voice prompt interface. 
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· Voicemail Channel Reservation 
For calls going to voicemail from the IP Office, the IP Office can restrict how many sessions of various types are
active at the same time. See Voicemail Channel Reservation . 

· DTMF Breakout (IP Office 5.0)
Previous breakout numbers for a user mailbox were set through the user voicemail settings . IP Office 5.0+
allows system defaults to be set. These are then applied to all user mailboxes unless the users own settings
differ. 

· Reception / Breakout (DTMF 0) 
The number to which a caller is transferred if they press 0 while listening to the mailbox greeting rather
than leaving a message (*0 on embedded voicemail).

· For systems set to Intuity emulation mode, the mailbox user can also access this option when
collecting their messages by dialing *0. 

· If the mailbox has been reached through a call flow containing a Leave Mail action, the option
provided when 0 is pressed are: 

· For IP Office mode, the call follows the Leave Mail action's Failure or Success results
connections depending on whether the caller pressed 0 before or after the record tone.

· For Intuity mode, pressing 0 always follows the Reception / Breakout (DTMF 0) setting. 

· Breakout (DTMF 2) 
The number to which a caller is transferred if they press 2 while listening to the mailbox greeting rather
than leaving a message (*2 on embedded voicemail). For pre-5.0 systems this option is not support for
Voicemail Pro running in IP Office mailbox mode. 

· Breakout (DTMF 3) 
The number to which a caller is transferred if they press 3 while listening to the mailbox greeting rather
than leaving a message (*3 on embedded voicemail). For pre-5.0 systems this option is not support for
Voicemail Pro running in IP Office mailbox mode.

· SIP Settings 
These options are available when the IP Office configuration contains a SIP line or H323 SCN line. The values
may be used when the voicemail server makes calls using a SIP trunk or to a SIP device. 

· SIP Name: Default = User name. 
The value from this field is used when the From field of the SIP URI being used for a SIP call is set to Use
Internal Data.

· SIP Display Name (Alias): Default = User name. 
The value from this field is used when the Display Name field of the SIP URI being used for a SIP call is
set to Use Internal Data.

· Contact: Default = User name. 
The value from this field is used when the Contact field of the SIP URI being used for a SIP call is set to
Use Internal Data.

· Anonymous: Default = Off. 
If the From field in the SIP URI is set to Use Internal Data, selecting this option inserts Anonymous into
that field rather than the SIP Name set above.

3.Click OK to save any changes.

4.Send the configuration back to the IP Office. 
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5.3 User Voicemail Settings
Voicemail can be configured for each individual user in IP Office Manager. 

1.Open IP Office Manager.

2.In the Navigation pane, click  User and select the individual user.

3.Select the Voicemail tab. 

· Voicemail Code / Confirm Voicemail Code 
These fields are used to set or change the user's mailbox passcode. 

· If the voicemail server is set to Intuity Emulation mode, mailbox users are asked to set a voicemail code
the first time that they access the mailbox. 

· Voicemail On Default = On
When on, the mailbox is used by the IP Office to answer the user's unanswered calls or calls when the user's
extension returns busy. Note that selecting off does not disable use of the user's mailbox. Messages can still be
forward to their mailbox and recordings can be placed in it. The mailbox can also still be accessed to collect
messages. 

· Voicemail Help Default = Off
For voicemail systems running IP Office mailbox mode, this option controls whether users retrieving messages
are automatically given an additional prompt "For help at any time press 8." If switched off, users can still
press 8 for help. For voicemail systems running in Intuity emulation mode, this option has no effect. On those
systems the default access greeting always includes the prompt "For help at any time, press *4" (*H in the US
locale).

· Voicemail Ringback Default = Off
When on, if the user has a new message, the voicemail server can call the user's extension whenever the
extension changes from off-hook to on-hook. The voicemail server will not ring the extension more than once
every 30 seconds. 

· Voicemail Email: Default = Blank (No voicemail email features) 
This field is used to set the user or group email address used by the voicemail server for voicemail email
operation. When an address is entered, the additional Voicemail Email control below are selectable to configure
the type of voicemail email service that should be provided. 

· Use of voicemail email requires the voicemail pro server to have been configured to use either a local MAPI
email client or an SMTP email server account. See Voicemail Email Installation . 

· The use of voicemail email for the sending (automatic or manual) of email messages with wav files
attached should be considered with care. A one-minute message creates a 1MB .wav file. 

· Voicemail Email Default = Off
If an email address is entered for the user or group, the following options become selectable. These control the
mode of automatic voicemail email operation provided by the voicemail server whenever the voicemail mailbox
receives a new voicemail message. 

· Users can change their voicemail email mode using visual voice. If the voicemail server is set to IP
Office mode, user can also change their voicemail email mode through the telephone prompts. The
ability to change the voicemail email mode can also be provided in a call flow using a Personal
Options Menu action or a Generic action. 

· If the voicemail server is set to IP Office mode, users can manually forward a message to email. 
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· Off
If off, none of the options below are used for automatic voicemail email. Users can also select this mode
by dialing *03 from their extension. 

· Copy
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, a copy of
the message is attached to an email and sent to the email address. There is no mailbox synchronization
between the email and voicemail mailboxes. For example reading and deletion of the email message does
not affect the message in the voicemail mailbox or the message waiting indication provided for that new
message. 

· Forward
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, that
message is attached to an email and sent to the email address. No copy of the voicemail message is
retained in the voicemail mailbox and their is no message waiting indication. As with Copy, their is no
mailbox synchronization between the email and voicemail mailboxes. Users can also select this mode by
dialing *01 from their extension. 

· UMS Exchange 2007
Voicemail Pro 5.0+ supports voicemail email to an Exchange 2007 server email account. For users and
groups also enabled for UMS Web Services this significantly changes their mailbox operation. The
Exchange Server inbox is used as their voicemail message store and features such as message waiting
indication are set by new messages in that location rather than the voicemail mailbox on the voicemail
server. Telephone access to voicemail messages, including Visual Voice access, is redirected to the
Exchange 2007 mailbox. See UMS Exchange 2007 Installation  and UMS Exchange 2007. 

· Alert
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, a simple
email message is sent to the email address. This is an email message announcing details of the voicemail
message but with no copy of the voicemail message attached. Users can also select this mode by dialing 
*02 from their extension. 

· UMS Web Services 
If selected, the user is able to use UMS  to access their mailbox. UMS options allow messages to be
accessed via a web browser, an IMAP compatible email application or an Exchange 2007 email account. The
use this function is subject to licenses. 

· DTMF Breakout
When a caller is directed to voicemail to leave a message, they can be given the option to be transferred to a
different extension. The greeting message needs to be recorded telling the caller the options available. The
extension numbers that they can be transferred to are entered in the fields below. For IP Office 5.0+, these
system default values can be set for these numbers and are used unless a different number is set within these
user settings. 

· Reception / Breakout (DTMF 0) 
The number to which a caller is transferred if they press 0 while listening to the mailbox greeting rather
than leaving a message (*0 on embedded voicemail).

· For systems set to Intuity emulation mode, the mailbox user can also access this option when
collecting their messages by dialing *0. 

· If the mailbox has been reached through a call flow containing a Leave Mail action, the option
provided when 0 is pressed are: 

· For IP Office mode, the call follows the Leave Mail action's Failure or Success results
connections depending on whether the caller pressed 0 before or after the record tone.

· For Intuity mode, pressing 0 always follows the Reception / Breakout (DTMF 0) setting. 

· Breakout (DTMF 2) 
The number to which a caller is transferred if they press 2 while listening to the mailbox greeting rather
than leaving a message (*2 on embedded voicemail). For pre-5.0 systems this option is not support for
Voicemail Pro running in IP Office mailbox mode. 

· Breakout (DTMF 3) 
The number to which a caller is transferred if they press 3 while listening to the mailbox greeting rather
than leaving a message (*3 on embedded voicemail). For pre-5.0 systems this option is not support for
Voicemail Pro running in IP Office mailbox mode.

4.Click OK to save the voicemail changes for the user.

5.Amend any other user details, then save and merge the configuration changes.
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5.4 User Source Numbers
The Source numbers can be changed for individual users in IP Office Manager. The Source Numbers tab gives a list of Dial
In Source Numbers. Several of these numbers can relate to voicemail operation. The source number settings that can be
used for Voicemail Pro are:

· V<Caller's ICLID> = Voicemail Trusted Source Access. 
Strings prefixed with a v indicate numbers from which access to the user's mailbox is allowed without requiring
entry of the mailbox's voicemail code.

· When in Intuity mode users will still have to enter their voicemail code if they use the Messages button on their
telephone. However, If they have a button programmed to collect voicemail they can access their mailbox
without entering their voicemail code.

· H<Group Name> = Hunt Group Voicemail Indication. 
Allows the user to receive message waiting indication for new group messages. Enter H followed by the group
name, for example HMain for the group Main. 

· P<Telephone Number> = Voicemail Ringback Number. 
This entry sets the destination for callback (outbound alert) calls from voicemail. Enter P followed by the telephone
number including any necessary external dialing prefix, for example P917325559876. This facility is only
available when using Voicemail Pro through which a default Callback or a user specific Callback start point has been
configured. This feature is separate from voicemail ringback which alerts the user's own extension.

To add a source number:

1.Open IP Office Manager.

2.In the Navigation pane, click  User and select the individual user.

3.View the Source Numbers tab.

4.Click Add. 

5.Enter the number in the Source Number field at the bottom of the window.

6.Click OK and save the configuration file.
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IP Office Configuration: User Source Numbers

5.5 Hunt Group Settings
Voicemail can be configured for each hunt group on the IP Office system. This section looks at the basic voicemail settings.

Voicemail Answer Time
For IP Office 4.0+, the condition under which calls targeted to a hunt group go to voicemail has been changed to a
timeout. For calls waiting to be answered, once this timeout expires the call is redirected to voicemail regardless of where
it is in the hunt group. 

Hunt Group Settings
1.Open IP Office Manager.

2.In the Navigation pane, click  Hunt Group and select the hunt group.

3.Select the Voicemail tab.

· Voicemail Code / Confirm Voicemail Code 
Enter a voicemail code between 1-15 digits in the Voicemail Code field. This is required when users retrieve
voicemail messages for the hunt group remotely, for example from an extension that is not a member of the
hunt group or from an external telephone.

· Voicemail Email: Default = Blank (No voicemail email features) 
This field is used to set the user or group email address used by the voicemail server for voicemail email
operation. When an address is entered, the additional Voicemail Email control below are selectable to configure
the type of voicemail email service that should be provided. 

· Use of voicemail email requires the voicemail pro server to have been configured to use either a local MAPI
email client or an SMTP email server account. See Voicemail Email Installation . 

· The use of voicemail email for the sending (automatic or manual) of email messages with wav files
attached should be considered with care. A one-minute message creates a 1MB .wav file. 

· Voicemail Email Default = Off
If an email address is entered for the user or group, the following options become selectable. These control the
mode of automatic voicemail email operation provided by the voicemail server whenever the voicemail mailbox
receives a new voicemail message. 
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· Users can change their voicemail email mode using visual voice. If the voicemail server is set to IP
Office mode, user can also change their voicemail email mode through the telephone prompts. The
ability to change the voicemail email mode can also be provided in a call flow using a Personal
Options Menu action or a Generic action. 

· If the voicemail server is set to IP Office mode, users can manually forward a message to email. 

· Off
If off, none of the options below are used for automatic voicemail email. Users can also select this mode
by dialing *03 from their extension. 

· Copy
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, a copy of
the message is attached to an email and sent to the email address. There is no mailbox synchronization
between the email and voicemail mailboxes. For example reading and deletion of the email message does
not affect the message in the voicemail mailbox or the message waiting indication provided for that new
message. 

· Forward
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, that
message is attached to an email and sent to the email address. No copy of the voicemail message is
retained in the voicemail mailbox and their is no message waiting indication. As with Copy, their is no
mailbox synchronization between the email and voicemail mailboxes. Users can also select this mode by
dialing *01 from their extension. 

· UMS Exchange 2007
Voicemail Pro 5.0+ supports voicemail email to an Exchange 2007 server email account. For users and
groups also enabled for UMS Web Services this significantly changes their mailbox operation. The
Exchange Server inbox is used as their voicemail message store and features such as message waiting
indication are set by new messages in that location rather than the voicemail mailbox on the voicemail
server. Telephone access to voicemail messages, including Visual Voice access, is redirected to the
Exchange 2007 mailbox. See UMS Exchange 2007 Installation  and UMS Exchange 2007. 

· Alert
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, a simple
email message is sent to the email address. This is an email message announcing details of the voicemail
message but with no copy of the voicemail message attached. Users can also select this mode by dialing 
*02 from their extension. 

· Voicemail On Default = On
When on, the mailbox is used by the IP Office to answer the user's unanswered calls or calls when the user's
extension returns busy. Note that selecting off does not disable use of the user's mailbox. Messages can still be
forward to their mailbox and recordings can be placed in it. The mailbox can also still be accessed to collect
messages. 

· Voicemail Help Default = Off
For voicemail systems running IP Office mailbox mode, this option controls whether users retrieving messages
are automatically given an additional prompt "For help at any time press 8." If switched off, users can still
press 8 for help. For voicemail systems running in Intuity emulation mode, this option has no effect. On those
systems the default access greeting always includes the prompt "For help at any time, press *4" (*H in the US
locale).

· Broadcast 
Select the option Broadcast if you want any voicemail messages left for the hunt group to be forwarded to the
mailboxes of the individual group members. The original message in the hunt group mailbox is deleted after
being broadcast. 

· UMS Web Service (IP Office 5.0+)
If selected, the hunt group mailbox can be accessing using UMS  via a web browser or an IMAP compatible
email application. 

4.Click OK and save the configuration.
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5.6 Voicemail Channel Reservations
By default inbound calls routed from IP Office to voicemail are able to use any available voicemail channels, up to the limit
of the number of licensed channels , regardless of how many calls of the same type are already in progress. However, if
required, channels can be reserved for different types of inbound calls to the voicemail server. 

Voicemail channel reservations can be made for:

· Auto Attendant 

· Announcements 

· Voice recording 

· Mailbox access 

· Mandatory voice recording 

It is worth checking the voicemail channel reservations if there are problems. If insufficient voicemail channels are
available:

· Internal calls to an auto attendant are queued. The call will queue until a resource becomes available.

· Announcements are not heard by the caller, but the call is routed correctly.

· Manual voice recording is activated but no recording is made. The call will continue.

· Users are placed in a queue when trying to access their mailbox access.

· A user with mandatory recording on outgoing calls (internal and external) gets a busy tone.

· A call on a line with mandatory recording set will be barred.

To change voicemail channel reservations:

1.Open IP Office Manager and the load the configuration.

2.In the Navigation pane click  System and select the system.

3.Click the Voicemail tab. 

4.Amend the channel reservations as required. By default the values are 0. 
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To view the utilization of voicemail channels:

1.Open the System Status Application.

2.Click Resources. The System Resources summary is displayed. The following details are displayed:

· The number of voicemail channels available.

· The number of channels in use.

· Congestion information

Channel Restrictions

· The Voicemail Pro server has restrictions on the number of channels it can use for different types of outgoing calls
that it can make. These limits are separate for each of the call types. When a limit is reached, further calls of that
type are delayed until one of the existing calls is completed. These limitations are not controlled by Voicemail
Channel Reservation  settings. 

· Outcalling can use up to 5 channels at any time. 

· Conference center invitation calls can use up to 5 channels at any time. 

· Callback calls can use up to 2 channels at any time. 

· Alarm calls can use up to 2 channels at any time. 
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Chapter 6.
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6. System Preferences
A range of voicemail server settings can be set through the Voicemail Pro client. 

To change the Voicemail Pro Preferences

1.Click the Preferences  icon and then choose General or VPNM. Alternatively, from the Administration menu,
select Preferences and then choose General or VPNM.

2.Select the System Preferences tab required.

· General  
General voicemail server settings. 

· Directories  
Set the folder paths for different file locations. 

· Housekeeping  
Set the times for automatic deletion of different types of messages. Also set the default playback order. 

· Email  
Select the email mode (MAPI or SMTP) used by the voicemail server for its email functions and configure
various settings for the selected mode. 

· SNMP Alarm  
Set the criteria which will cause the voicemail server to send alarms via the IP Office. 

· Outcalling  
Set the default times for outcalling operation and the frequency of outcalling retires. 

· VPNM  
If VPNM is installed and licensed, this tab is available to set the locations of the remote VPNM servers and
the mailbox users on those servers. 
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System Preferences:  

6.1 General
Although the default IP Office configuration settings allow voicemail to start operating almost immediately, as soon as a
voicemail server is running on the LAN, there are some general system preferences that you can set or change.

To set up general system preferences:

1.Display the main Voicemail Pro window.

2.From the Administration menu, select Preferences > General. 

· Debug Level 
Set the level of information that the server should output for logging if required. 

· Default Telephony Interface: Default = Intuity 
Select the mailbox operation mode for all mailboxes. The options are IP Office mode or Intuity emulation mode. 

· Voicemail Password: Default = Blank 
A voicemail password is optional for the voicemail server is optional. If you set a password here, it must match the
Voicemail Password configured within the IP Office's security settings. See Identifying the Voicemail Server PC . 

· Client/Server Connection Timeout (mins): Default =5 minutes. 
The voicemail server only allows one Voicemail Pro client to be connected at a time. This timeout logs out an
inactive client, stopping it from preventing another client from connecting. 

· Min. Message Length (secs): Default = 3 seconds. 
By default the minimum message length is 3 seconds in IP Office mailbox mode, 0 seconds in Intuity emulation
mode. This field allows the minimum length to be set between 0 and 10 seconds. Messages under this length are
deleted immediately.

· Max. Message Length (secs): Default = 120 seconds. 
This value sets the maximum length for messages. The default message length is 120 seconds. The maximum
message length is 3600 seconds (60 minutes). 1 minute equals approximately 1MB of disk space.

· Max. Call\VRL Record Length (secs):  Default =3600 seconds. 
This value sets the maximum recording time for recorded calls. The default and maximum length is 3600 seconds
(60 minutes). 

· Play Advice on Call Recording: Default = On 
If selected, an advice warning is played whenever call recording is started advising the callers that their call is being
recorded. This may be a legal requirement in some countries and so should not be disabled without checking first.

· System Fax Number: Default = Blank 
This field can be used to set the number of the fax machine to which all incoming faxes should be directed. If a fax
board is being used, this number must match the number of the extension that is connected to the fax board of the
fax server PC. 
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· Intuity mailbox owners have the additional option to define their own personal fax number instead of the
system fax number. As the system administrator, you still need to set a system fax number to enable mailbox
owners to override it with their preferred personal fax number. Incoming calls are directed to Voicemail Pro and
then Voicemail Pro redirects fax calls to the mailbox owner's personal fax number, if one has been set. For
information mailbox owners should read the Intuity Mailbox User Guide.

· If your fax system requires prefix addressing, for example the C3000 fax server, do not type a fax number in
the System Fax Number box. Instead type the number to use as a prefix so that a fax message can be
identified and forwarded to the extension number of the intended recipient. For example, if the prefix were 55,
a fax message for extension 201 would have the prefix of 55 automatically added so that the complete number
would become 55201.

· System Fax Number 
By default fax detection is not enabled when Voicemail Pro is first installed. When fax detection is enabled, any fax
calls that are left in a voicemail mailbox, are redirected to this system fax number.

· Use as a Prefix 
If your fax system does not use prefix addressing, leave this box unchecked. For this feature to work, you also
need to set up a short code. 

· Enable Fax Sub-Addressing 
Most fax servers perform fax forwarding based on DTMF signaling received with the fax call. Check the Enable
Fax Sub-Addressing box so that the DTMF signal is passed to the fax server after the call has been answered
so that the fax can be forwarded to the email address of the intended recipient.

3.Click OK.

4.Click  Save and Make Live and select Yes.
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System Preferences: General

6.2 Directories
When Voicemail Pro is installed some default folder locations are used. You can change these if required.

To set the location of Voicemail system folders:

1.Display the main Voicemail Pro window.

2.From the Administration menu, select Preferences > General.

3.Click the Directories tab. 

· Voicemail Server Directory 
The path to the folder where the voicemail server program is to be stored. This is the folder where the file 
Root.vmp is saved when the Save & Make Live option is used.

· Voicemail Server Speech Directory 
The path to the folder where the libraries of speech prompts are to be stored. 

· Remote Campaign Directory 
The path to the folder where the campaign files are to be stored.

4.Click OK.

5.Click  Save and Make Live and select Yes.
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6.3 Email
The Email tab is used to configure which email mode (MAPI or SMTP) the voicemail server should use and the settings for
that mode. 

6.3.1 MAPI
This form is used to configure MAPI settings for use by the voicemail server. Not supported for use with a Linux based
server. 

 

· Enable MAPI 
Selecting this option will switch the voicemail server to using MAPI for its email options rather than SMTP. 

· Profile 
This is used to select the MAPI email account the voicemail server should use to provide visibility to the email
account mailboxes for which it requires access. The profile must exist within the MAPI email client on the
server PC and must be useable by the Windows account under which the Voicemail Pro service is running.
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6.3.2 SMTP Sender
These settings are used to configure the SMTP server and server account that the voicemail server uses for sending emails
using SMTP.

Multiple servers can be configured. The first entry specifies the default SMTP server used for sending emails if there is no
other entry matching the domain specified in the email destination address. Additional servers can be added when
different settings are required for sending emails to specific domains. For example, the default may be configured for the
customer's internal network exchange server with addition entries added for emails to external email domain addresses
such as yahoo.com.

· Messaging Between Voicemail Servers 
VPNM, distributed voicemail servers and primary/backup voicemail servers all use SMTP to exchange information
and messages between the voicemail servers. When that is the case the first entry in the SMTP Sender list must
be the one used and needs to be configured for that service with the domain and server setting both matching the
IP address or fully qualified domain of the voicemail server. 

In the example below, the first entry is being used for messages to other voicemail servers. Its own address is used as
both the domain and server settings as an SMTP service on the same server as the voicemail service is used (eg. IIS SMTP
on the Windows server). The next entry is used for other emails that use the customer's general email domain address
with the server set to the customers email server. A third entry has been added to send some emails generated by Email
Actions in call flows direct to an external email service. 

· The first two entries in the example above can be combined. Voicemail server to server synchronization uses the 
Domain setting only whereas other email services use the Server address and other setting. 
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· Logging 
If selected, SMTP logging  by the server is enabled. 

· Servers 
This section is used to enter details of the SMTP server or servers to which the voicemail server send its messages. 
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To add a server, click on the . icon. To edit the server, click on the  icon. To delete a server entry, click on . 

· Mail Domain 
This field is used differently depending on whether it is the first entry in the list or not: 

· For the first server entry in the list: 
This is the default outgoing email settings. It also sets the mail destination domain on which the voicemail
server filters incoming messages (see below) and so is repeated on the SMTP Receiver  tab. 

· Messaging Between Voicemail Servers 
For messaging between voicemail servers, the first entry in the SMTP Sender list must be the one
configured and used. Each server uses the SMTP server service on the same server PC as the voicemail
service. For example a Windows based servers uses the SMTP email provided by the IIS on the same
server. The voicemail  service also uses the domain set to filter incoming SMTP mails received by the SMTP
server. For this to work, the domain entered should be the fully qualified name of the server on which the
voicemail server is running, for example vmpro1.example.com. Any incoming messages where the
recipient mail domain is not exactly the same as the specified domain are ignored. The recipient can either
by vmsyncmaster, vmsyncslave or the name or extension of a mailbox on the Voicemail Pro server, for
example Extn201@vmprocentral.example.com or 201@vmprocentral.example.com. 

· For subsequent entries: 
The domain specifies that these settings should be used for emails sent to the matching domain. The entry
must be a fully qualified name resolvable by DNS or an IP address.

· Server 
This specifies the IP address or fully qualified domain name of the SMTP server to which messages are sent. 

· For the first server entry in the list: 
Where messaging between voicemail servers is being used (central, backup and or distributed servers), the first
entry is used and will match the domain set above. 

· For subsequent entries: 
It will be the address of the email server that will handle emails for recipients other than another voicemail server
on the network. 

· Port Number 
This is port to which messages are sent, usually 25.

· Sender (Identifier)
Note that some servers will only accept emails from a specific sender or sender domain. If left blank, the voicemail
server will insert a sender using either the email address set for the voice mailbox user if set or otherwise using the
best matching name it can resolve from the IP Office. 

· Server Requires Authentication 
This check box indicates whether the connection to send SMTP messages to the mail server requires authentication
with that server. The authentication will typically be to the name and password of a mailbox account configured on
that server. 

· Account Name 
Sets the name to use for authentication.

· Password 
Set the password to use for authentication.

· User Challenge Response Authentication (Cram MD5) 
If this check box is selected, the name and password are sent using Cram MD5.
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6.3.3 SMTP Receiver
This tab is used to set where the voicemail server checks for incoming SMTP messages. The SMTP Receiver setting can
be set to either Internal or External. 

· Internal  
Use this option for voicemail servers running on the IP Office Application Server server. 

· External  
Use this option when the voicemail server is on a server where is co-exists with a third-party SMTP application, for
example an IIS server with SMTP enabled.

Internal
The Internal setting can be used when the voicemail server should check the appropriate account on an SMTP server for
waiting messages. The server settings will be pre-populated using the entries from the SMTP Sender  form. 

· Distributed/Primary/Backup Voicemail
This is the option that should be used when the voicemail server is a IP Office Application Server (Linux) based
server in a network distributed voicemail servers are being used or is a server in a primary/backup voicemail
server pairing. 

 

· Port 
This is the port on which the Voicemail Pro server listens for incoming messages. The default is 25. 

· Domain 
This is the domain destination address for which the server will accept incoming emails. Note that it matches the
domain set by the first server entry in the SMTP Sender  tab. 

· Messaging Between Voicemail Servers 
For messaging between voicemail servers, the first entry in the SMTP Sender list must be the one
configured and used. Each server uses the SMTP server service on the same server PC as the voicemail
service. For example a Windows based servers uses the SMTP email provided by the IIS on the same
server. The voicemail  service also uses the domain set to filter incoming SMTP mails received by the SMTP
server. For this to work, the domain entered should be the fully qualified name of the server on which the
voicemail server is running, for example vmpro1.example.com. Any incoming messages where the
recipient mail domain is not exactly the same as the specified domain are ignored. The recipient can either
by vmsyncmaster, vmsyncslave or the name or extension of a mailbox on the Voicemail Pro server, for
example Extn201@vmprocentral.example.com or 201@vmprocentral.example.com. 
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External
The External setting should be used when the voicemail server should check the mail drop folder on a local SMTP server
for SMTP email messages. For example, when there is an IIS server with SMTP enabled on the same server PC as the
Voicemail Pro server. 

· Distributed/Primary/Backup Voicemail
This is the option that should be used when the voicemail server is a Windows based server in a network
distributed voicemail servers are being used or is a server in a primary/backup voicemail server pairing. 

 

· Port 
This is the port on which the server receives incoming SMTP emails. 

· Domain 
This is the domain destination address for which the server will accept incoming emails. Note that it matches the
domain set by the first server entry in the SMTP Sender  tab. 

· Messaging Between Voicemail Servers 
For messaging between voicemail servers, the first entry in the SMTP Sender list must be the one
configured and used. Each server uses the SMTP server service on the same server PC as the voicemail
service. For example a Windows based servers uses the SMTP email provided by the IIS on the same
server. The voicemail  service also uses the domain set to filter incoming SMTP mails received by the SMTP
server. For this to work, the domain entered should be the fully qualified name of the server on which the
voicemail server is running, for example vmpro1.example.com. Any incoming messages where the
recipient mail domain is not exactly the same as the specified domain are ignored. The recipient can either
by vmsyncmaster, vmsyncslave or the name or extension of a mailbox on the Voicemail Pro server, for
example Extn201@vmprocentral.example.com or 201@vmprocentral.example.com. 
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6.4 Housekeeping
This tab is used to set the Voicemail Pro server settings for automatically deleting messages and for the default playback
order of messages. For Voicemail Pro 6.0+ it is also used to access options for backing up and restoring voicemail
messages and settings. 

The voicemail servers housekeeping settings can be used to configure how long messages and recording are retained
before the server will automatically delete them. The playback order for different types of messages can also be set. Note
that the housekeeping deletion settings are not applicable for messages stored on the Exchange server. 

1.From the Administration menu, select Preferences > General.

2.Click the Housekeeping tab. 

 

3.Delete after 
Sets the time, in hours, after which messages of various types automatically deleted. A value of 0 disables
automatic deletion. The actual deletion is performed during the next idle period during which there are no calls to or
from the voicemail server.

4.Playback Order 
Sets the order of playback used for different message types. The options are first in-first out (FIFO) and last in-first
out (LIFO). FIFO is the default. 

· The different message status types are: 

· New 
This status is applied to messages where neither the header or the message content has been played. 

· Old 
This status is applied to messages where the user has played the message content but has not marked the
message as saved. 

· Saved 
This status is applied to messages that have been marked as saved by the user. 

· Unopened 
This status is used for messages where, in Intuity emulation mode, the user has played the message
header but has not played the message content. 

· New Recordings 
This status is used for recordings that have not been played. 

· Old Recordings 
This status is used for recordings that have been played. 
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· Deleted Messages 
This status is used for messages that have been marked as deleted through mailbox access. 

5.Click OK.

6.Click  Save and Make Live and select Yes.

6.5 SNMP Alarm
The IP Office system can be configured to send alarms. These alarms can be sent from the IP Office using SNMP, SMTP
email or Syslog alarm formats. This tab is used to sets the levels at which the voicemail server will indicate to the IP Office
to send an alarm. 

 To set up disk space and recording time alarms:

1.Display the main Voicemail Pro window.

2.From the Administration menu, select Preferences > General.

3.Click the SNMP Alarm tab.

4.Choose the Alarm Threshold Unit either Disk Space Left (MB) or Recording Time left (minutes).

5.In the Alarm Threshold Level box, type the number of units (minutes or MB) left at which SNMP alarms are to be
triggered. The minimum is 11. This value also sets two further SNMP alarm levels which are:

· Space OK Alarm 
This alarm is triggered when the amount of available space returns to above a level set at Alarm Threshold
Level plus 30.

· Critical Alarm 
This alarm is set at 30 or, when the Alarm Threshold Level is less than 40, at Alarm Threshold Level minus 10.
Currently the critical alarm value will decrease in accordance with the above rule. Note however that it does
not increment upwards when the Alarm Threshold is increased again. To reset the critical alarm back to 30,
click Default Settings.

6.To return to the default alarm settings, click Default Settings. The Alarm Threshold Level is reset to 60. The Space
OK level is reset to 90. The Critical Alarm level is reset to 30.

7.Click OK.

8.Click  Save and Make Live and select Yes.
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6.6 Outcalling
The outcalling preferences in Voicemail Pro are defaults for global operation. Mailbox owners can configure their own
outcalling options from their telephone, for example, create their own time profile. 

Details on how users can configure outcalling are found in the Intuity Mailbox guide and Phone Manager User Guide. 

A timeout value can also be set by a user. This is how long outcalling will attempt to call a number before giving up. 

To set the global outcalling preferences:

1.Display the main Voicemail Pro window.

2.From the Administration menu, select Preferences > General.

3.Click the Outcalling tab.

4.Select the times that outcalling is active in the System Times section.

· Prime Times 
The time period that outcalling is to be active as default for the system.

· Peak Times 
The busiest working hours.

5.Set the retry settings in the System Retry Settings section.

6.The Number of Retries can be between 0 and 10. If the message is not collected after the last retry, no
notification is sent until another new message is delivered in the user's mailbox.

7.The Retry Interval for each retry attempt. The interval is the length of time between each attempt to ring to
targeted number again. The 6th to 10th retries use the default retry interval.

8.Double-click a selected retry time to edit the interval between retries. The New interval number window opens
where the length of time between each attempt to ring the target number can be changed. Click OK to save the
change and return to the Outcalling window.

9.Click OK.

10.Click  Save and Make Live and select Yes.
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6.7 VPNM

This set of preferences is used to add a list of the remote VPNM servers and mailbox users on those servers. 

· ! These features are not supported on a Linux based Voicemail Pro server. 

To open the VPN window:

1. Start the Voicemail Pro Client.

2. From the Administration menu, select Preferences > VPNM. The VPNM window opens. 

To add a VPNM server:

1. In the VPNM Server(s) section, click Add.

2. Enter the fully qualified domain name of the remote VPNM destination (the remote Voicemail Pro server PC or Avaya
Interchange).

3. Enter the two digit access prefix, if these are being used.

4. Click OK.

To delete a VPNM server:

1. In the VPNM Server(s) section, select the server that you need to delete.

2. Click Delete. When a server is deleted, all of the users associated with that server are also deleted.
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To add a user to VPNM server:

1. In the Users for VPNM Server(s) section, click Add. The Adding a new user window opens.

2. Enter details for the user. All of these details MUST be completed before the user can be added.

· Select the VPIM server from the listing.

· Enter the user's full name. The user's full name is used by the local Voicemail Pro's dial by name feature.

· Enter the user's extension. The local extension number is used as the local mailbox number and so should not
conflict with any existing local number.

· Enter the user's remote extension. The remote extension number should be the user's real extension number.
Typically this and the 'local extension number' are kept the same using a unique extension number dial plan
for the linked systems.

· Enter the user's full telephone number. The full telephone number should be a dialable number that is routed
to the user's extension or mailbox.

3. Click OK to save the details and return to the VPNM configuration window.
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To add a group of users:

1. (Optional) Check the option Enable WildCard. When this option is selected you can use the question mark symbol
(?) to represent any number.

2. In the Users for VPNM Server(s) section, click Add Range. The Adding a range of users window opens.

3. Enter details for the users. All of these details MUST be completed before the users can be added.

· Select the VPNM server to which you want to add the users.

· Enter the start number of the extension range.

· Enter the local prefix.

· Enter remote prefix.

4. Click OK to save the details and return to the VPNM configuration window.

To change details of a VPNM user:

1. In the Users for VPNM Server(s) section, select the name of the user whose details need to be changed.

2. Click Modify. You can change the user's full name, the local extension number and the full telephone number.



Voicemail Pro Installation Page 110
- Issue 01a (01 May 2011)IP Office Release 7.0



Voicemail Pro Installation Page 111
- Issue 01a (01 May 2011)IP Office Release 7.0

Centralized Voicemail Pro

Chapter 7.
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7. Centralized Voicemail Pro
A Small Community Network (SCN) consists of several IP Office telephone systems. These are connected using H323
Lines where the Supplementary Services settings of the lines has been set to IP Office SCN. For details refer to the IP
Office Manager documentation. 

Within a Small Community Network, the following options for providing voicemail are supported:

· Centralized Voicemail  
Centralized Voicemail Pro uses a single Voicemail Pro server
to provide voicemail services for all IP Offices in the Small
Community Network. Except for use of ContactStore, only
the central IP Office hosting the voicemail server requires
licensing for Voicemail Pro operation and features. 

· Licenses: The central IP Office is licensed as normal for
Voicemail Pro operation and the voicemail features
required. The other IP Offices only require licenses for
UMS and or for ContactStore if required. 

· Centralized Voicemail with Fallback IP Office  
Control of the voicemail server can be assumed by another
IP Office if the central IP Office becomes unavailable.

· IP Office Release 5.0+ with Voicemail Pro 5.0+. 

· Licenses: The fallback IP Office that assumes control of
the voicemail server requires licenses for Voicemail Pro
operation and the features required during fallback. 

· Centralized Voicemail with a Backup Voicemail Server
 

The central IP Office hosting the voicemail server can be
configured with the IP address of a backup voicemail server.
During normal operation, call flows and other settings on the
backup server are kept synchronized with those of the
primary voicemail server. If the primary voicemail server
becomes unavailable to the network, voicemail services are
provided by the backup voicemail server. 

· IP Office Release 6.0+ with Voicemail Pro 6.0+. 

· IIS SMTP is used to exchange information between the
servers. 

· Licenses: The existing licenses are used. 

· Centralized Voicemail with Distributed Voicemail
Servers  
Other IP Offices in the Small Community Network can host
their own Voicemail Pro server. That server is then used for
the IP Office's voicemail functions except message storage. 

· IP Office Release 6.0+ with Voicemail Pro 6.0+. 

· IIS SMTP is used to exchange information between the
servers. 

· The distributed voicemail server provides all voicemail
services except voicemail collection for its associated IP
Office. 

· Licenses: Each IP Office using a distributed voicemail
server must have licenses for Voicemail Pro operation
and the voicemail features required. 

In all the cases above, the central voicemail server remains the store for messages and recordings (except for Exchange
UMS users). The central voicemail server does message waiting indication and is the voicemail server used for message
collection. Only when the central server is temporarily unavailable will the backup or any distributed server do message
storage and collection. In those scenarios, when the central server is restored, messages collected by the backup or
distributed servers are forwarded to the central server. 

Combinations  of the solutions above can be deployed. For example using a backup server and fallback IP Office
control. 
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Centralized Voicemail Pro:  

7.1 Centralized Voicemail
Within a Small Community Network, a single Voicemail Pro server can be used to provide voicemail features for all the IP
Offices in the SCN. 

One IP Office is configured for operation with the Voicemail Pro server as normal, including the license for voicemail
operation and the features required. This IP Office is then regarded as the central IP Office for voicemail. 

Within the other IP Office systems, the voicemail settings are configured to indicate that they get their voicemail services
from the central IP Office. These IP Offices do not need licenses for voicemail (except for ContactStore and or UMS if
required). 

Summary of IP Office Settings
Once the IP Office SCN has been setup, the following settings are used in the IP Office systems to provide voicemail
operation for all the IP Offices. 

IP Office Settings Central IP Office Other IP Offices

Voicemail Type Voicemail Pro Centralized Voicemail

Voicemail IP Address Set to the voicemail server PC's IP address. Not used.

Voicemail Destination Not used. Set to the Outgoing Group ID of the H323
Line to the central IP Office. 

Licenses This system needs licenses  for all the
Voicemail Pro features required. 

The other IP Offices only require licenses for
UMS and or for ContactStore if required. 

When accessing a voicemail server that is acting as centralized voicemail server, the Voicemail Pro will display 
Centralized Voicemail in the title bar. 

10
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7.2 Fallback IP Office Control
IP Office Release 5.0+ supports a number of fallback features for Small Community Networks. In conjunction with
Voicemail Pro 5.0+, fallback can include one of the IP Offices assuming control of the voicemail server should the central
IP Office become unavailable on the network. 

Normal Operation 
During normal operation, voicemail
services for the Small Community
Network are provided by the
central IP Office communicating
with the voicemail server. 

 

Fallback Control Operation 
If the central IP Office becomes
unavailable to the network, control
of voicemail services for the Small
Community Network is assumed by
the fallback IP Office. 

· WARNING 
During the transition of voicemail control, access to voicemail may be unavailable for several minutes. Existing
voicemail calls are disconnected and new calls are routed as if voicemail is unavailable. The same applies when the
central IP Office is restored. 

Setup and Requirements for Voicemail Fallback

· Within the configuration of the central IP Office hosting the voicemail server, on the H323 Line to the fallback IP
Office;

· The Supplementary Services setting should be changed from IP Office - SCN to IP Office -SCN Fallback. 

· The option Backs up my Voicemail should then be selected from the SCN Backup Options. 

· The fallback IP Office is configured for centralized voicemail as normal. However its configuration must also include
licenses for the Voicemail Pro support and the voicemail features required during fallback. 
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7.3 Backup Voicemail Server Operation
For IP Office Release 6.0, the central IP Office hosting the Voicemail Pro server can be configured with the IP address of a
backup voicemail server. If the central voicemail server becomes unavailable to the network, the backup server will be
used to provide voicemail services. This option requires the voicemail servers to be running Voicemail Pro 6.0 or higher. 

Centralized voicemail with a backup server during normal operation.

During Normal Operation: 

· Voicemail services and message
storage for the IP Offices is provided
by the primary voicemail server. 

· Call flows and other settings configured
on the backup voicemail server are
synchronized with those of the central
voicemail server. 

· Messages are synchronized but the
central voicemail server remains the
message store accessed for message
collection. 

· The synchronization is done using IIS
SMTP email between the servers.

Centralized voicemail with a backup server during backup operation. 

During Backup Operation: 
If the central voicemail server become
unavailable to the network: 

· The backup voicemail server provides
voicemail services for the IP Offices. 

· New messages are left on the backup
server.

After Backup Operation 
When the central server is restored to the
network:

· It does not automatically resume
control. However messages and
changes that occurred while it was
unavailable are synchronized from the
backup server.

· If the backup server fails, the central
sever resumes control as the active
server.

· Call flows defined on the central server are synchronized with the backup server.

· Call flows defined on the central server cannot be modified on the backup server.

· Call flows cannot be defined on the backup server.

· Call flows defined on a distributed server are not synchronized to the central or backup servers. 
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Configuring Backup Server Operation
1.The Voicemail Pro server software is installed as normal on the backup server PC. The voicemail server is not

specifically configured as being a backup server. 

2.The central IP Office hosting the primary voicemail server is configured with the IP addresses of both the primary
voicemail server and the backup voicemail server. 

3.The other IP Offices are configured for centralized or distributed voicemail as normal. 
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7.4 Distributed Voicemail Servers
For IP Office Release 6.0, remote IP Offices in the Small Community Network can be associated with another voicemail
server in addition to the centralized voicemail server. The additional distributed server then provides all voicemail services
(except message storage and collection) for that IP Office. This requires the remote IP Office to have licenses for voicemail
operation and the features it requires. 

While the distributed server does message recording, it forwards all messages to the central voicemail server. The
messages are transferred between systems using an IIS SMTP email services. For mailbox users, message waiting
indication and message collection is still done using the central voicemail server. 

Centralized Voicemail with Additional
Distributed Voicemail Servers 
In this scenario, an additional voicemail
sever has been added to the Small
Community Network. One of the IP Office
is configured to use that server for its
voicemail services. 

· Other IP Offices continue to use
centralized voicemail as normal. 

· An IP Office that is using a distributed
voicemail server cannot also be used as
the fallback IP Office  for the central
voicemail server.

· The synchronization is done using IIS
SMTP email between the servers.

Multiple Distributed Servers 
Additional distributed voicemail servers
can be added as required by the
individual IP Office sites in the Small
Community Network. 

Sharing Distributed Voicemail Servers
The same distributed voicemail server can
be shared by several IP Offices. The
services it provided to each will depend
on the licenses that each has. 
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Summary of IP Office Configuration Settings for Distributed Voicemail Severs

IP Office Settings Central IP Office Other IP Offices IP Office with Distributed
Server

Voicemail Type Voicemail Pro Centralized Voicemail Distributed Voicemail

Voicemail IP
Address

Set to the central voicemail
server PC's IP address. 

Not used. Set to the distributed voicemail
server PC's IP address. 

Voicemail
Destination

Not used. Set to the Outgoing Group ID
of the H323 Line to the central IP
Office. 

Set to the Outgoing Group ID
of the H323 Line to the central IP
Office. 

Licenses This system needs licenses
for Voicemail Pro and all
voicemail features required. 

The other IP Offices only require
licenses for UMS and or for
ContactStore if required. 

This system needs licenses
for Voicemail Pro and all
voicemail features required. 

Configuring Distributed Voicemail Server Operation
1.The centralized voicemail server for the SCN and its central IP Office are configured as normal. 

2.The Voicemail Pro server software is installed as normal any distributed voicemail server PC's. The distributed
voicemail server is not specifically configured as being a distributed server. 

3.Each IP Office hosting a distributed voicemail server is configured with the Voicemail Type set to Distributed
Voicemail. 

· The Voicemail Destination is set the Outgoing Group ID of the H323 trunk to the central IP Office hosting
the centralized voicemail server. 

· The Voicemail IP Address is set to the IP address of the PC running the distributed voicemail server for the
IP Office. 

10 10
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7.5 Combined Options
The various centralized voicemail options (standard, fallback, backup and distributed) can be used within the same Small
Community Network. 

· An IP Office using a distributed voicemail cannot be used as the fallback IP Office for the central IP Office. 

· A distributed voicemail server cannot also be used as the backup voicemail server. 
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Example: Combined Fallback Control and Backup Server Operation
In the example below the fallback IP Office control  and backup voicemail server  peration can be combined. 

Central Voicemail Server controlled by Fallback IP Office

· Central IP Office
Unavailable 
If the central IP Office
becomes unavailable on the
network, the fallback IP Office
assumes control of voicemail
services using the centralized
voicemail server. 

Backup Voicemail Server controlled by Central IP Office

· Central Voicemail
Unavailable 
If the central voicemail server
becomes unavailable on the
network, the central IP Office
will switch to using the
backup voicemail server. 

Combined Backup Voicemail Server and Fallback IP Office Operation

· Central IP Office and
Central Voicemail Server
Unavailable 
If both the central IP Office
and the central voicemail
server become unavailable to
the network, voicemail
services will switch to the
backup voicemail server
under control of the fallback
IP Office. 

114 115
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Centralized Voicemail Pro: Combined Options

7.6 Installation Notes

SMTP Configuration
Both the distributed voicemail and backup voicemail scenarios use the same mechanism for the information exchange
between the servers. That mechanism uses SMTP emails between the IIS on each of the voicemail servers. Note that this
means a server with Microsoft Exchange installed (such as a SBS server) cannot be used as Exchange replaces the IIS
SMTP service. 

The following notes apply to both scenarios unless specifically stated as otherwise. 

1.Install and Enable IIS 
All the voicemail servers (central, distributed and backup) require IIS to be installed and enabled on the server
before installation of the Voicemail Pro server software. 

1.Start the Internet Information Services manager. 

2.Right-click on the Default SMTP Virtual Server and select Properties. 

3.Select the Messages tab. Deselect the Limit Message Size and Limit number of messages per
connection options. 

2.Configure Each Voicemail Pro Server for SMTP Email via IIS 
Following installation of the Voicemail Pro server software, its should be configured for SMTP email operation as
follows:

a.By default the Voicemail Pro server installs defaulted to SMTP email operation. However this should be
checked. 

1.Start the Voicemail Pro Client. Click  Preferences and select General.

2.Click the Email tab.

3.Ensure that the MAPI  settings are not enabled. . 

4.Select the SMTP Sender  sub tab. The first entry in the list must be configured for SMTP between the
voicemail servers. Set the Domain and Server to the  fully qualified domain name of the voicemail
server. 

96
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· For a Windows based voicemail server, these emails will be received on port 25 by IIS and will be
placed in its mail drop folder. To obtain the name, right-click on My Computer and select Properties
. The Computer Name tab shows the information that should be used as Full computer name. The
name must be used, IP addresses are not used. 

5.Select the SMTP Receiver  sub tab. 

· For a Windows based server, set the SMTP Receiver as External and set the Drop Folder address
to be the IIS mail drop folder (usually C:\Inetpub\mailroot\Drop). For a Linux based server set
the SMTP Receiver as Internal. 

· Click OK. 

6.Click  Save & Make Live.

3.Ensure that Port 25 is Not Blocked 
Many firewalls block access to port 25 by default. Check that the firewall software being used on the server is
configured to allow VMProV5Svc.exe as an exception. 

100
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Centralized Voicemail Pro: Installation Notes

4.DNS Host Routing (Optional) 
SMTP operation uses fully qualified domain names that need to be resolved to IP addresses by the network's DNS
server. To guarantee name resolution the hosts files on each server can be used. Note however that if this method
is used, any changes to IP addresses of servers will need to be reflected in the file update. Locate the file C:
\Windows\System32\drivers\etc\hosts and open it in a text editor such as WordPad. Add IP address and fully
qualified domain name entries for each of the other voicemail servers. 
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Voicemail Pro Configuration
In all scenarios, each Voicemail Pro server should use the same basic configuration settings, ie. the same voicemail mode
(Intuity or IP Office) and the same housekeeping settings. 

IP Office Configuration
Configuring Distributed Voicemail Server Operation

1.The centralized voicemail server for the SCN and its central IP Office are configured as normal. 

2.Each IP Office not hosting a distributed voicemail server is configured with the Voicemail Type set to Centralized
Voicemail. 

· The Voicemail Destination is set the Outgoing Group ID of the H323 trunk to the central IP Office hosting
the centralized voicemail server. 

Configuring Distributed Voicemail Server Operation

1.The centralized voicemail server for the SCN and its central IP Office are configured as normal. 

2.The Voicemail Pro server software is installed as normal any distributed voicemail server PC's. The distributed
voicemail server is not specifically configured as being a distributed server. 

3.Each IP Office hosting a distributed voicemail server is configured with the Voicemail Type set to Distributed
Voicemail. 

· The Voicemail Destination is set the Outgoing Group ID of the H323 trunk to the central IP Office hosting
the centralized voicemail server. 

· The Voicemail IP Address is set to the IP address of the PC running the distributed voicemail server for the
IP Office. 

Configuring Backup Server Operation

1.The Voicemail Pro server software is installed as normal on the backup server PC. The voicemail server is not
specifically configured as being a backup server. 

2.The central IP Office hosting the primary voicemail server is configured with the IP addresses of both the primary
voicemail server and the backup voicemail server. 

3.The other IP Offices are configured for centralized or distributed voicemail as normal. 
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Centralized Voicemail Pro: Installation Notes

Check the Server Connections
1.Check Connection to the Central Server 

In the following tests, remember to use the fully qualified domain name of each server. 

a.Ping Test 
Make a ping from the server to the central server, for example ping vmpro1.example.com. You should see a
series of 4 successful replies from the sever.

b.Telnet Test 
Make a telnet test from the server to the central server, for example telnet vmpro1.example.com 25. You
should receive a response from the email server within IIS. Enter quit to close the telnet connection. 

2.Check Connection from the Central Server 
Repeat the ping and telnet tests, this time from the central server to the backup or distributed server. 

Checking Status with the Voicemail Pro Client
When connected to a Voicemail Pro server using the Voicemail Pro client, the client title bar will display the role assumed
by that voicemail server; Centralized Voicemail, Backup Voicemail or Distributed Voicemail. 

When connected to the backup voicemail server, if it is the active server, the title will have changed from Backup
Voicemail to Backup Voicemail (Live). 

When connected to the centralized voicemail server, the Distributed Voicemails folder can be selected to display details
of the distributed servers and the state of the connection with each. The Result will be either: 

· In Progress 
The servers are synchronizing information via SMTP. 

· Up-To-Date 
The servers are synchronized. 
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Appendix

Chapter 8.
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8. Appendix
8.1 SMTP Logging

SMTP error logging is enabled to generate a log of SMTP activity. 

For a Windows based Voicemail Pro installation, the activity is logged in a file in C:\Program Files\Avaya\IP
Office\Voicemail Pro\VM\logs. The file name includes a date stamp for the day on which it is generated. For a Linux
based server the log files can be archived and downloaded using the web control menus. 

SMTP Error Codes

Value Meaning

1 An exception has occurred.

3 The process has run out of memory.

4 An error has occurred due to a problem with the message body or attachments.

5 There was a problem initiating the conversation with the mail server. Ensure the setting of the Domain property
is correct.

6 There was an error terminating the conversation with the SMTP mail server.

7 The "From" address was not formatted correctly or was rejected by the SMTP mail server. Some SMTP servers
will only accept mail from particular addresses or domains. SMTP mail servers may also reject a From address if
the server can not successfully do a reverse lookup on the address.

8 An error was reported in response to receipt address. The SMTP server may refuse to handle mail for unknown
recipients.

9 There was an error connecting to the SMTP mail server.

10 There was an error opening the file. If you have specified file attachments, ensure that they exist and that you
have access to them.

11 There was an error reading a file. If you have specified file attachments, ensure that they exist and that you
have access to them.

15 No mail server specified.

16 There was a problem with the connection and a socket error occurred.

17 Could not resolve host.

18 Connected but server sent back bad response.

19 Could not create thread.

20 Canceled as a result of calling the Cancel method.

21 The operation timed-out while the host was being resolved.

22 The operation timed-out while connecting.

24 ESMTP Authentication failed.

25 The selected ESMTP Authentication mode is not supported by the server.

26 ESMPT Authentication protocol error.

27 Socket Timeout error.

105 Invalid license key.
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Appendix: SMTP Logging

8.2 Installing VoiceMail Pro as an ACM Gateway
Complete the steps in this section to install Voicemail Pro as an ACM Gateway. There is only one type of installation for the
Voicemail Pro ACM Gateway. Therefore you are not offered the choice of custom, compact or typical during the installation
process.

To install the ACM Gateway:

1. Insert the IP Office Applications DVD. Click on the link for Voicemail Pro and then double-click on setup.exe.
The Choose Setup Language window opens.

2. Select the installation language. This language is used for the installation and for the default language prompts.

3. Click OK. Installation preparation begins.

4. Voicemail Pro requires Microsoft .NET 2.0 Framework. If this version is not detected, you are prompted to install it.
Click Yes to install Microsoft .NET 2.0 Framework and follow the instructions on the screen. 

5. If the Modify, repair or remove the program window appears you need to follow the upgrade process . 

6. In the Welcome window, click Next. The Customer Information window opens.

7. In the Customer Information window, type a user name and the company name or use the default names that are
proposed. These settings do not affect Voicemail Pro when it is installed.

8. In the same window choose the option that determines who should be able to use Voicemail Pro when it has been
installed. The recommended option is Anyone who uses this computer (all users).

9. In the Customer Information window, click Next. The Choose Destination Location window opens.

10. In the Choose Destination Location window, click Browse and locate the folder where the Voicemail Pro files are to
be installed. Otherwise, click Next to use the proposed folder. The Messaging Components window opens so that
you can choose the components that you want to install.

11. In the Messaging Components window, highlight ACM Gateway.

12. Click Next. The Service Account Name window opens. Details of the default administrator account may already be
filled in.

13. In the Service Account Name window, type the User Name and Password for the user account under which the
Voicemail Pro service should log on and run. This should be the Voicemail account created previously on the
domain and Exchange server. Alternatively, click Browse and select from the list of available PC or network
accounts or click Next to use the proposed account details. The Select Program Folder window opens.

14. By default, the program folders are created in a folder called IP Office. You can specify a different folder or select
one from the list of existing folders. To specify a different folder, type the folder name in the Program Folders box.
Alternatively, to use an existing folder, highlight a name in the list of existing folders.

15. Click Next. The account details that you have entered are verified. If you entered a new user name, a message is
displayed to ask if you want to create a new PC user account with the specified name and password. Click Yes. The
Select Program Folder window opens.

16. Select the program folder where you would like the icons for the Voicemail Pro components to be added. By default,
the program icons are added to IP Office.

17. Click Next. The Start Copying Files window opens. Before any copying starts, you are presented with a summary of
the settings that you have chosen so far.

18. Review the settings to make sure that they are what you expect. Scroll down if necessary.

19. If for any reason the details are not what you expect, click Back and make the necessary changes. When you are
satisfied that the details are correct, click Next to start copying the files. The Setup Status window opens to keep
you informed while the installation takes place.

20. When the installation is complete you are prompted to restart the computer. Choose Yes I want to restart my
computer now.

21. Click Finish to restart now.

22. When the computer restarts, log back in. The IP Office Voicemail Pro - ACM Gateway Settings window opens.

23. In the Mail Server box, type the name of the mail server to use.

24. Choose Message Networking/Interchange to use Interchange or Modular Messaging to use Modular Messaging.1.

25. Click Next. The IP Office Voicemail Pro SMTP Email Settings window opens.

· In the Mail Server box, type the name of the SMTP mail server. This should be the fully qualified domain
name.

· In the Port Number box, type the number of the receiving port on the SMTP mail server. The default is 25.

· In the Mail Drop box, type the name of the destination folder for outgoing emails on the SMTP Server.
Alternatively, click the Browse button and select the folder to use.

· To enforce server authentication, check the Server Requires Authentication box. This is optional. If you
check this option you also need to provide the Account Name and Password that need to be entered. You can
also choose whether or not to set the Use Challenge Response Authentication option.

26. Click Finish. An attempt is made to validate the email settings. If everything has been installed correctly and the
license requirements are met, you are prompted to start the Voicemail service. If the attempt to connect with the

28
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SMTP server fails, an error message is displayed. You might need to start the Voicemail service manually. See 
Starting the Voicemail Pro Service .

27. Click OK to acknowledge the message. You have now finished installing the Voicemail Pro ACM Gateway software.

 

26
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Appendix: Installing VoiceMail Pro as an ACM Gateway

8.3 Installing Networked Messaging (VPNM)
Voicemail Pro Networked Messaging (VPNM) allows users to forward voicemail to mailboxes on remote voicemail systems.
This is done by adding a VPNM component to the Voicemail Pro installation.

The messages are transferred between systems using an SMTP/MIME mail format to encode both the voice part of the
message and additional message details.

Here is a diagram to illustrate VPNM between two IP Office systems.

 

Here is a diagram of a sample VPNM configuration between an IP Office and Avaya Interchange. Depending on how your
IP Network is set up, the configuration will differ slightly.

 

Up to 2000 mailboxes are supported per VPNM server and there is no constraint on the number of VPNM servers.
However, to distinguish between dial plans you might need to allocate a dial pre-fix to each server. A maximum of 99 pre-
fixes are available.

This section summarizes the steps required for installing VPNM between two IP Office systems and between an IP Office
system and an Intuity Audix system through Avaya Interchange.

The instructions provided here should be read in conjunction with the other Avaya guides, for example "Avaya Interchange
Release 5.4, Adding a VPIM System to Your Network". This is because the setup for Interchange VPIM is the same as for
VPNM.
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8.3.1 Requirements for VPNM

Check that the following requirements have been before attempting to install VPNM:

· A Voicemail Pro server with VPNM installed connected to each IP Office system. Each system will need a license for
both Voicemail Pro and VPNM.

· All systems in the VPNM network need to be tested to ensure that they can communicate across the IP network. It
is suggested that you test the following:

· Ping the IP Addresses.

· Ping the computer names. If in a domain, ping the fully qualified domain name.

· The VMPro Servers must have an SMTP server installed. This can be done using the SMTP component of Internet
Information Service (IIS).

· To test type "Telnet <the name of the SMTP server> 25".

· Server names, where entered, must be fully qualified domain names.

· Voicemail Pro should not be installed on the same server as Exchange and/or the domain controller.
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Appendix: Installing Networked Messaging (VPNM)

8.3.2 Installing VoiceMail Pro with VPNM Support
For Voicemail Pro 6.1, the VPNM components are embedded parts of the Voicemail Pro service and so automatically
installed. 
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8.3.3 Configuring VPNM Preferences

This set of preferences is used to add a list of the remote VPNM servers and mailbox users on those servers. 

· ! These features are not supported on a Linux based Voicemail Pro server. 

To open the VPN window:

1. Start the Voicemail Pro Client.

2. From the Administration menu, select Preferences > VPNM. The VPNM window opens. 

To add a VPNM server:

1. In the VPNM Server(s) section, click Add.

2. Enter the fully qualified domain name of the remote VPNM destination (the remote Voicemail Pro server PC or Avaya
Interchange).

3. Enter the two digit access prefix, if these are being used.

4. Click OK.

To delete a VPNM server:

1. In the VPNM Server(s) section, select the server that you need to delete.

2. Click Delete. When a server is deleted, all of the users associated with that server are also deleted.
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Appendix: Installing Networked Messaging (VPNM)

To add a user to VPNM server:

1. In the Users for VPNM Server(s) section, click Add. The Adding a new user window opens.

2. Enter details for the user. All of these details MUST be completed before the user can be added.

· Select the VPIM server from the listing.

· Enter the user's full name. The user's full name is used by the local Voicemail Pro's dial by name feature.

· Enter the user's extension. The local extension number is used as the local mailbox number and so should not
conflict with any existing local number.

· Enter the user's remote extension. The remote extension number should be the user's real extension number.
Typically this and the 'local extension number' are kept the same using a unique extension number dial plan
for the linked systems.

· Enter the user's full telephone number. The full telephone number should be a dialable number that is routed
to the user's extension or mailbox.

3. Click OK to save the details and return to the VPNM configuration window.
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To add a group of users:

1. (Optional) Check the option Enable WildCard. When this option is selected you can use the question mark symbol
(?) to represent any number.

2. In the Users for VPNM Server(s) section, click Add Range. The Adding a range of users window opens.

3. Enter details for the users. All of these details MUST be completed before the users can be added.

· Select the VPNM server to which you want to add the users.

· Enter the start number of the extension range.

· Enter the local prefix.

· Enter remote prefix.

4. Click OK to save the details and return to the VPNM configuration window.

To change details of a VPNM user:

1. In the Users for VPNM Server(s) section, select the name of the user whose details need to be changed.

2. Click Modify. You can change the user's full name, the local extension number and the full telephone number.
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Appendix: Installing Networked Messaging (VPNM)

8.3.4 Testing a VPNM Setup
It is advisable to test the VPNM setup.

To test the VPNM setup:

1. Dial into voicemail from one of the systems and record a message.

2. When selecting the target extension, enter an extension from the other system as specified in the VPNM Preferences
screen.

3. The message should be delivered to the other systems Voicemail Pro server into C:\\Inetpub\mailroot\Drop.

4. The VPNMreceiver Service checks the Drop directory approximately every 30 seconds. When it finds a message in
the Drop directory, it will send the message to the relevant extension's voicemail box on the remote system.
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